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Multi-Standard Display Processor

Transit Protection-Important Notice

REMOVING THE TRANSIT TIE-WRAPS

When supplied the PCB card will be secured by 2 tie-wraps, looped around the card ejectors and through 2
holes in the base plate.  Before installing the rack both of the tie-wraps should be removed by cutting off the
tie-wrap knot and completely removing the tie-wrap.

REPLACING THE TRANSIT TIE-WRAPS

Before shipping, the transit tie-wraps should be replaced with the
spare tie-wraps supplied (part no. RMW610). With the unit
free-standing ensure that the PCB card is pushed fully home
using the card ejectors. From the inside of the unit, feed the
tongue of the tie-wrap behind the card ejector and through the
base plate using the rear of the 2 holes.  From the outside, feed
the tongue back through the base plate using the other hole, past
the front of the card ejector, feed through the eye of the tie-wrap,
pull tight and cut off the excess.
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 About this Manual

This manual covers the following product:

• SuperVisor Multi-Standard Display Processor

 Software Version Amendments
Notes about Versions Fitted

Firmware. This SuperVisor is shipped with Version 7.0 of the firmware.

 Manufacturers Notice
Copyright protection claimed includes all forms and matters of copyrightable material and information now
allowed by statutory or judicial law or hereinafter granted, including without limitation, material generated from
the software programs which are displayed on the screen such as icons, screen display looks etc.

Reproduction or disassembly of embedded computer programs or algorithms prohibited.

Information in this manual and software are subject to change without notice and does not represent a
commitment on the part of Snell & Wilcox Ltd. The software described in this manual is furnished under a
licence agreement and may not be reproduced or copied in any manner without prior agreement with Snell &
Wilcox Ltd. or their authorised agents.

 Important Warning
Before installation ensure that the warning label on the rear top of the unit is read and understood

DO NOT REST UNIT ON END OR STRIKE THE REAR CONNECTORS
DO NOT TRANSPORT WITH 75 OHM TERMINATORS  ATTACHED TO INPUT LOOP THROUGH OR OTHER  REAR CONNECTIONS

FAILURE TO OBSERVE THESE PRECAUTIONS MAY RESULT IN DAMAGE TO THE UNIT.
CAUTION
FRAGILE! CAUTION

FRAGILE!

DO NOT REST UNIT ON END OR STRIKE THE REAR CONNECTORS
DO NOT TRANSPORT WITH 75 OHM TERMINATORS ATTACHED TO INPUT LOOP THROUGH OR

OTHER REAR CONNECTIONS
FAILURE TO OBSERVE THESE PRECAUTIONS MAY RESULT IN DAMAGE TO THE UNIT.
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Safety Warnings
Always ensure that the unit is properly earthed and power connections correctly made.

This equipment shall be supplied from a power system providing a PROTECTIVE EARTH  connection and
having a neutral connection which can be reliably identified.

The power terminals of the IEC mains input connector on the rear panel are
identified as shown below:

E = Protective Earth Conductor

N = Neutral Conductor

L = Live Conductor

Power cable supplied for countries other than the USA
The equipment is normally shipped with a power cable with a standard IEC moulded free socket on one end
and a standard IEC moulded plug on the other. If you are required to remove the moulded mains supply plug,
dispose of the plug immediately in a safe manner. The colour code for the lead is as follows:

GREEN/YELLOW lead connected to E (Protective Earth Conductor)
BLUE lead connected to N (Neutral Conductor)
BROWN lead connected to L (Live Conductor)

Power cable supplied for the USA
The equipment is shipped with a power cord with a standard IEC moulded free socket on one end and a
standard 3-pin plug on the other. If you are required to remove the moulded mains supply plug, dispose of the
plug immediately in a safe manner. The colour code for the lead is as follows:

GREEN lead connected to E (Protective Earth Conductor)
WHITE lead connected to N (Neutral Conductor)
BLACK lead connected to L (Live Conductor)

The terminals of the IEC mains supply
lead are identified as shown opposite:

Note that for equipment that is not fitted with a mains power switch, to comply with BS60950 Clauses 1.7.2 and
2.6.9, the power outlet supplying power to the unit should be close to the unit and easily accessible.

 Warnings 
Voltages within this unit can be lethal under certain circumstances. Where power
is required to be connected to the unit during servicing great care must be taken
to avoid contact with these voltages.

Maintenance should only be carried out by suitably qualified personnel.

No part of this publication may be transmitted or reproduced in any form or by any means, electronic or
mechanical, including photocopy, recording or any information storage and retrieval system, without
permission being granted, in writing, by the publishers or their authorised agents.
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EMC Standards
This unit conforms to the following standards:

Electromagnetic Compatibility-Generic Immunity Standard BS EN 50082-1:1992

The European Standard EN 50082-1:1992 has the status of a British Standard and is related to European
Council Directive 89/336/EEC dated 3rd May 1989.

Electromagnetic Compatibility-Generic Emission Standard BS EN 50081-1:1992

The European Standard EN 50081-1:1992 has the status of a British Standard and is related to European
Council Directive 89/336/EEC dated 3rd May 1989.

Federal Communications Commission Rules Part 15, Class A :1998

Safety Standards

This unit conforms to EN60065:1992 as amended by amendment A1(May 1993) and
amendment A2(March 1994). Specification for safety of technology equipment, including
electrical business equipment.

EMC Performance of Cables and Connectors
Snell & Wilcox products are designed to meet or exceed the requirements of the appropriate European EMC
standards. In order to achieve this performance in real installations it is essential to use cables and connectors
with good EMC characteristics.

All signal connections (including remote control connections) shall be made with screened cables terminated in
connectors having a metal shell. The cable screen shall have a large-area contact with the metal shell.

COAXIAL CABLES

Coaxial cables connections (particularly serial digital video connections) shall be made with high-quality
double-screened coaxial cables such as Belden 8281 or BBC type PSF1/2M.

D-TYPE CONNECTORS

D-type connectors shall have metal shells making good RF contact with the cable screen. Connectors having
"dimples" which improve the contact between the plug and socket shells, are recommended.

 Packing List
The unit is supplied in a dedicated packing carton provided by the manufacturer and should not be accepted if
delivered in inferior or unauthorised materials. Carefully unpack the carton and check for any shipping damage
or shortages.

Check against the following list. Report any shortages or damage to the supplier immediately.

• Shipping Damage
• Shortages
• Mainframe

• Module(s)
• Power cable
• Operator's Handbook
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SECTION 1

 Introduction 

DESCRIPTION

The SUPERVISOR is a display processor designed to improve the quality of pictures displayed on devices
such as large screen projectors, video walls, large screen monitors etc. with input sources of base band video
and computer graphics.

The unit is contained in a single 1U rack case, meeting current EMC regulations (BS50081-1 for emission and
BS50082-1 for immunity) 

Control is via an advanced Multi-Function front panel using a powerful Menu system and push buttons or by a
comprehensive remote control system (see Section 2)

Fuse

POWER 

88-264V(AC) 

50/60Hz 0.6A 

FUSE 1A(T)

CVBS G/Y B/Pb R/Pr SYNC

APPLE MACOUT

IN

DIGITAL 
REF

IBM VGAMONITORREF

R/PrB/PbG/Y

VIDEO

SYNC/HD VD Y/C

R
O

LL
C

A
LL

INPUTS

R
E

M
O

T
E

 

SUPOPS220296 SNELL & WILCOX 1.1



SECTION 1

 Introduction 

FEATURES

HIGH QUALITY improvement of images displayed on large screen devices

Full Spatio-Temporal Interpolation with 9 point aperture (NOT a line doubler)

Line and field rate up-conversion to reduce raster visibility and flicker

Accepts inputs of 625, 525 and VGA Computer standards (including interlaced and progressive)

HDTV input option available

Analogue Component inputs (Composite input option available)

Provides a variety of outputs with increased line and field rates in interlaced or progressive form

VGA and MAC computer standard outputs 

Multi-standard genlocking facilities

Can change aspect ratio between 4:3 and 16:9 formats with size variation

Two dimensional image re-sizing 

Accurate positioning of image

Unique ten step gamma correction

Built-in test pattern generator for display alignment

Facility to KEY(overlay) computer pictures into the video input signal

Self-contained in a 1U rack case with low power consumption

Single segment video wall display driver/processor built-in

Two menu-driven LCD displays for simple operation

Six memory locations for storage and recall of selected parameters

SUPOPS220296 SNELL & WILCOX 1.2



SECTION 2

 Specifications 

INPUT CONNECTIONS

Component RGB(S) Separate inputs of  Red, Green and Blue at standard level of 
0.7V p-p , (with  0.3V Sync on Green  channel  or separate 
syncs) when via loop-through BNC connectors for 75 Ohms.

Component Separate inputs of  Y, Pb and Pr at standard level of 0.7V p-p 
luminance  (with  0.3V Syncs or separate  syncs) and 
0.7V p-p  U & V, when terminated in 75 Ohms using the same 
loop-through BNC connectors as the RGB inputs.

Syncs Mixed syncs  at 0.3V to  2V p-p via BNC 
loop-through connectors for 75 Ohms.  

Computer Standard IBM CGA,VGA ,SVGA levels via 15 pin 
High Density ‘D’ connector
Standard MAC levels via 15 pin ‘D’ connector
Note that  SuperVisor  requires separate H and V  syncs from 
both  VGA and MAC  inputs; it is not designed to work with 
a composite sync input from these sources.

If Optional PAL or NTSC Decoder is Fitted:

Composite Composite video at 1V p-p level when terminated in 75 Ohms
via loop-through BNC connectors

Separated Y/C Y signal 1V p-p, C signal 0.3V p-p burst , both terminated in 
75 Ohms  via  4-pin Mini-DIN connector.

Reference Standard Video or black burst  via BNC connector terminated 
in 75 Ohms 
Digital  positive or negative going Horizontal and Vertical 
drive,TTL levels  via  active loop-through,9 pin ‘D’ Connectors

Note that this connector is used for the HDTV Tri-Sync input 
when the HDTV option is fitted.

INPUT STANDARDS

Video 625 Line, 50 Hz, interlaced 2:1
525 Line, 59.94 Hz, interlaced 2:1

Computer (IBM Standard) CGA 320x400/60/1:1
VGA 640x480 /60/1:1
SVGA 800x600/56/1:1

HDTV (Optional) 1250 Line, 50 Hz, interlaced 2:1
1125 Line, 60 Hz, interlaced 2:1
1050 Line, 60 Hz, interlaced 2:1

SUPOPS060798 SNELL & WILCOX 2.1
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 Specifications 

OUTPUT CONNECTIONS

Component RGB Separate outputs of  Red, Green and Blue at standard level of 
0.7V p-p , (with Sync on Green  channel, see note 1) when 
terminated in 75 Ohms via the BNC connectors and via the 
14 pin multi-way connector.

OR

Component Separate outputs of  Y, Pb and Pr at standard level of 1V p-p 
luminance and 0.7V p-p  PbPr, when terminated in 75 Ohms 
using the same BNC connectors as the RGB  outputs and via 
the 14 pin multi-way connector. (Note 1)

Note 1: Syncs may also be added to the red and blue or U and V signals by means of a jumper link

 

Sync An output of standard mixed syncs at a level of  2V p-p into 
75 Ohms or at TTL compatible level, via BNC connector 
OR

HD An output of horizontal drive at a level of 2V p-p into 
75 Ohms or at TTL compatible level, using the same BNC 
connector as the Sync output 

VD An output of vertical drive at a level of 2V p-p into 
75 ohms or at TTL  compatible level via a BNC connector

Note: The sync/HD/VD output level is selected by links; see page 5.11 for details.

Digital Reference Digital  positive or negative going Horizontal and Vertical 
drive at TTL  compatible levels  via  9 pin ‘D’ Connector

SUPOPS060798 SNELL & WILCOX 2.2
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 Specifications 

OUTPUT SCANNING STANDARDS

Output Standards Available

Line Rate Field Rate Interlace  Comments VGA Key
or Pixels Hz Ratio Mode Available
   
625 100 2:1 No
625 50 1:1 No
1250 50 2:1 No
875 75 2:1 No
525 119.88 2:1 No
525 59.94 1:1 No
1050 59.94 2:1 No
735 89.90 2:1 No
320 x 400 60 1:1 CGA Yes
640 x 480 60 1:1 VGA Yes
800 x 600 56 1:1 SVGA Yes
800 x 600 60 1:1 SVGA Yes
800 x 600 72 1:1 SVGA Yes
800 x 600 75 1:1 SVGA Yes
640 x 480 67 1:1 MAC Yes
832 x 624 75 1:1 MAC Yes
1125 60 2:1 No

SUPOPS060798 SNELL & WILCOX 2.3
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 Specifications 

TECHNICAL DATA

Conditions: Input Signal  Component YPbPr and Composite unless other indicated. 
Output Signal 625 50 1:1 RGB.

Frequency Response YPbPr            -1 dB at 4 MHz, -3 dB at 8 MHz
Composite     -1 dB at 6 MHz

Pulse Response 
(YPbPr and Composite)

2T pulse to bar             <1% K rating 
2T pulse response       <1% K rating 
Bar response (20 us)   <1% K rating

Tilt Line tilt       <1% 
Field tilt      <1%

Residual Jitter <±10 ns

Y-C Delay Correction Horizontal                  ± 900 ns in 56 ns steps 
Vertical                      ± 8 lines in 1 line steps

Procamp Controls Video (Luma) gain    ± 3 dB
Chroma gain          ± 3 dB
Black level                ± 50 mV
NTSC hue                ± 20 degrees

SUPOPS060798 SNELL & WILCOX 2.4
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 Specifications 

OPERATIONAL CONTROLS

The Supervisor has  extremely flexible multi-function controls which combine hard and soft key functions.

SELECTABLE FUNCTIONS AND PARAMETERS

(See Section 3 ‘OPERATION’ for operating procedure) 

Function Parameter Select Range

Input Signals Composite 
(if decoder option fitted) Aspect Ratio 4:3/16:9
RGB/RGBS Aspect Ratio 4:3/16:9
YPbPr/YPbPrS Aspect Ratio 4:3/16:9
Y/C Aspect Ratio 4:3/16:9
VGA 320 x 400 Pixels  CGA
VGA 640 x 480 Pixels  VGA
VGA 800 x 600 Pixels  SVGA

Output Signals RGB/YPbPr RGB, YPbPr
Syncs Add Syncs to Green or Y

Mixed sync at SYNC/HD connector
HD at SYNC/HD connector and VD at VD connector

Genlock Off
Reference input
Digital input
Genlock H-Phase ± 1600ns
Genlock V-Phase ± 4 lines

SUPOPS060798 SNELL & WILCOX 2.5
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 Specifications 

Function Parameter Select Range

Pan Horizontal ± 75% of input picture width
Tilt Vertical   ± 75% of input  picture height

Size Horizontal Reduce by 1.5:1, increase by 4:1 
(Output picture size compared to input)

Size Vertical Reduce by 1.5:1, increase by 4:1
(Output picture size compared to input) 

Signal Processing Luminance gain ± 3dB
Chrominance gain ± 3dB
Black Level ± 50mV
NTSC Hue ± 20° (if decoder option fitted)

Pattern Generator Select Patterns 100% Bars
Bars and  Red
Crosshatch
Step (Gamma)
Ramp
Multiburst
Pluge
Black
White

Filter Characteristics Sharp(ness) Horizontal   0 to +9dB in 3dB steps
Vertical   0 to +9dB in 3dB steps

Effects Picture Y Invert On/Off
Monochrome On/Off
Gamma Correction 1 to 10 curve selections
Freeze frame 

Computer KEY Off
Wipe Vertical Wipe Point adjustable to cover all picture lines
Key Key from R+G+B, level adjustable 0 to 100%
Invert

Video Wall Wall Shape Select Video Wall  shape
1 x 2, 1 x 3, 1 x 4.
2 x 1, 2 x 2, 2 x 3, 2 x 4.
3 x 1, 3 x 2, 3 x 3, 3 x 4.
4 x 1, 4 x 2, 4 x 3, 4 x 4.

Cube Select Cube Number Choose 1 to 16

SUPOPS060798 SNELL & WILCOX 2.6
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 Specifications 

MAINFRAME

The unit is ruggedly constructed in a 19" steel rack mount case.

Dimensions 483mm wide, 45mm high, 395mm deep.
Weight 5kg.
Temperature range 0 to 40°C operating, -30 to +75° storage

Power Supply

Mains power 88V to 264V 50/60Hz
Input Connector IEC320 Fused 1A(T)
Power On/Off Switch Located behind drop-down front panel
Power Consumption 50VA  maximum
Cooling A cooling fan is fitted to the rear panel of the unit.

SUPOPS060798 SNELL & WILCOX 2.7
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 Remote Control 

Typical RollCall  System

ROLLCALL  OVERVIEW

The RollCall  system provides full remote control of compatible units using graphical control panels and may
be used to control many units simultaneously. The remote control software communicates via remote control
interface circuitry which may be a separate card fitted into a rack mount unit or, as in the SuperVisor, be integrated
into the main PCB.

Rollcall  communication may be via either a 9 pin ‘D’ connector configured to RS485 or via a 75 Ohm coaxial
cable connection to the network allowing long distance multi-drop coaxial inter-connections . The address of a
unit is set by two Hex switches, each unit having a different address. In addition the 9 pin ‘D’ connector may be
configured to be an RS422 port, allowing single point-to-point communication with a simplified set of Protocols.

The system may support multiple slave operation, multiple control operation or as a single network with a choice
of coaxial or RS485  interface connection. High data rates of 2.5Mbits/sec are used on the coaxial port and RS485
port, and up to 38.4Kbits/sec on RS422 port.

SUPOPS060798 SNELL & WILCOX 2.8
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 Remote Control 

SUPERVISOR ROLLCALL  CONNECTIONS

Coaxial Connection (a)

The RollCall  coaxial connection allows interfacing with other RollCall  compatible equipment, fitted with the
RollCall  BNC connector, over a maximum distance of 400 m using PSF1/2 cable or 300 m using RG59/U. 

Under these conditions control is available from any other RollCall  control device; conversely the SuperVisor
can then control other units connected to the RollCall  network.

RS485 to Front Panel

The SuperVisor mainframe may be remotely operated from the front panel using the ribbon cable connection
over a maximum cable length of 30 m.

9-pin ‘D’ Connection (b)

This system uses RS422 or RS485 interface for connection to a P.C. SW4 on the front edge of the SuperVisor
PCB  selects the required mode.

RS422 (SW4 in the down position)

This mode allows the unit to be connected to a P.C. and provides full control of all functions using a simplified
subset of RollCall  protocol. This Protocol is included in Appendix A. Data rate is 38.4 kbauds and maximum
recommended cable length is 30 m.
In this mode only point-to-point control of the connected SuperVisor is supported 

RS485 (SW4 in the up position)

This mode provides an interface at  2.5 Mbps which is fully RollCall  compatible, supporting all RollCall
capabilities. Note that any controller must  meet  full RollCall  specifications. For support and advice about
specific applications please contact Snell & Wilcox or your supplier. 

REMOTE CONTROL CONFIGURATIONS FOR SUPERVISOR

Remote SuperVisor Front Panel (up to 30 m)

This method allows the distance between the SuperVisor mainframe and its front panel to be extended by up to
30 metres using a Passive Shoebox. 

A shoebox is a standard 19" rack mount box but only 100 mm deep. This box allows standard 1U front panels to
be operated remotely from a mainframe and housed conveniently in the standard 19" format. 

The Passive Shoebox is a passive box requiring no external power (product code IQHSBOX-S) using RS485
communication (maximum cable length 30 m). This unit has the advantage of not requiring any mains power (low
voltage power is derived from a mainframe; for example a SuperVisor unit), allowing control from an  un-powered
location. A spare SuperVisor blank front panel is provided that can be fitted to the mainframe to replace the active
front panel which now resides in the shoebox.
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 Remote Control 

Remote Front Panel (over 30 m)

This method allows remote control over distances greater than 30 metres using an Active Shoebox.

An active form of the Shoebox is used (product code IQHSBOX-RC-AP-S) which is mains powered, and supplied
complete with a SuperVisor front panel and RollCall  remote control interface card for coaxial and RS422
communication systems.

The original SuperVisor front panel remains fitted to the mainframe and the shoebox, with a SuperVisor front
panel used to control the SuperVisor from a remote location. Communication is via the RollCall  BNC coaxial
system and dual control is possible. 

Remote Control from a Controller

RS422/RS485

Using this method the SuperVisor unit remains intact complete with its front panel fitted into the mainframe and
uses the 9 pin ‘D’  connector in the RS422 mode. Note that  for this mode of operation SW4 on the front of the
PCB must be in the DOWN (default) position.  
This allows the unit to be connected to a P.C. and provides full control of all functions using a simplified subset
of RollCall  protocol. This Protocol is include in Appendix A. Data rate is 38.4 kbauds and maximum
recommended cable length is 30 m.

It should be noted that when using RS422 (point-to-point connection) one serial port per unit is controlled; if RS485
is used (multiple-drop, SW4 set to the UP position) many units can be connected to the same bus.
The RS485 mode provides an interface at  2.5 Mbps which is RollCall  compatible. This has full RollCall
networking capabilities. Note that any controller must  meet  full RollCall  specifications. For support and advice
about specific applications please contact Snell & Wilcox or your supplier. 

Windows  Based Program

Snell & Wilcox can provide a Windows  based P.C. RollCall  program to control one or more units via using
either the RS232 port of the computer (an adapter to RS422 will be required) or via a RollCall  BNC coaxial
port, for which a P.C. card is available.

SUPOPS060798 SNELL & WILCOX 2.10
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 Remote Control 

Control of SuperVisor with other RollCall Units

Other RollCall units, fitted with a KUDOS IQ active front panel, may be used to control the SuperVisor.

The KUDOS IQ active front panel is very similar to the SuperVisor front panel, the only differences between the
two panels are the functions of some of the dedicated push buttons shown more clearly below:    

KUDOS IQ Active Front Panel

SuperVisor Front Panel            KUDOS IQ Active Front Panel

When using the KUDOS IQ active front panel to control the SuperVisor unit, the display windows and their
associated push buttons, will function in the same way as those on a SuperVisor front panel; however, the
dedicated push buttons will operate functions as described in Section 1of the KUDOS IQ  Modular System,
Operator’s Manual, 1U Active Control Panel, Dedicated Push Buttons.

To access the Pattern, Output, VGA, Preset, Save and Read functions (dedicated buttons on the SuperVisor
front panel, but buttons not available on the KUDOS IQ active front panel) connect to the SuperVisor unit using
the Modules function (see KUDOS IQ  Modular System, Operator’s Manual)  go to the SuperVisor main menu
and proceed as follows:

Pattern Select Patterns... from the menu to reveal the Pattern Select Menu and use the Pattern Active
function to enable or disable the pattern

Output Select Out Rate... from the menu to reveal the Output Scan Rate Menu and make the desired
selection

VGA Select VGA Key... from the menu to reveal the VGA Key Options Menu and use the VGA Key
Active function to enable or disable the VGA key function 

Preset Select System... from the menu to reveal the System Menu and use the Preset Unit function 

Save Select Memsave... from the menu to reveal the Memory Save Menu and save to the desired
memory location

Read Select Memread... from the menu to reveal the Memory Read Menu and read from the required
memory location

SUPOPS060798 SNELL & WILCOX 2.11



POWER CONNECTIONS

This is the IEC320 mains power connector suitable for
a standard IEC type power cable and contains a 1A(T)
fuse. If a fused type plug is fitted to the cable a fuse of
5A (F) rating should be installed. 

POWER ON/OFF SWITCH

The power ON/OFF switch is located behind the
drop-down front panel in the left hand corner.

LED INDICATORS

The green LED indicator on the front panel marked
POWER will be il luminated when the unit is
powered-up.

The LED marked ACTIVE will be illuminated when the
front panel is connected to and communicating with
the mainframe electronics.

The LED marked ERROR will flash indicating that
there has been a  communications error between the
front panel and the mainframe electronics.

 

REMOTE COMMUNICATIONS CONNECTOR

This 9 pin ‘D’ connector on the rear panel is the remote
control connector that allows interconnection to be
made to  remote or other front panels in a multiple-unit
system.

ROLLCALL

This single BNC connector allows the unit to be
connected to the RollCall  network communications
system. For more details of this system see Section 2.
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INPUT CONNECTIONS

COMPOSITE INPUT
(if decoder option is fitted)

This is the composite (CVBS) video input to the unit
via loop-through BNC connectors for 75 Ohms. If the
loop-through facility is not used a BNC 75 Ohm
terminating plug should be fitted on the unused
connector. Nominal input level is 1V p-p.

This input is selected using the front panel controls.

Y/C INPUT 
(if decoder option is fitted)

A Y/C separated luminance/chrominance type signal
may be connected to the unit via this 4-pin Mini-DIN
connector which terminates both signals in 75 Ohms.

Y input level is a nominal 1V p-p into 75 Ohms and C
level is a nominal 0.3V p-p colour burst into 75 Ohms.

Connections are given below:

CVBS G/Y B/PbY/C

INPUTS

 

CVBS G/Y

PLE MAC

VGA Y/C
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COMPONENT INPUTS

Component RGB or YPbPr inputs are accepted via
these three sets of loop-through BNC connectors for
75 Ohms.

If the loop-through facility is not used a BNC 75 Ohm
terminating plug should be fitted on the unused
connector. 

For RGB signals 

Connect Green signal to the G/Y connector
Connect Blue signal to the B/Pb connector
Connect Red signal to the R/Pr connector 

Signal levels are 0.7V p-p into 75 Ohms with syncs on
the green channel.  

For YPbPr signals

Connect Y signal to the G/Y connector
Connect Pb signal to the B/Pb connector
Connect Pr signal to the R/Pr connector   

Signal levels are 0.7V p-p into 75 Ohms with syncs on
the Y channel.  

This input and the signal format is selected using the
front panel controls.

SYNC INPUT

A loop-through connection via BNC connectors for 75
Ohms is provided that will accept a standard mixed
sync signal. This connection should be used if either
the RGB or YPbPr input is non-composite (contains no
sync information) and a source of separate syncs is
available.

If the loop-through facility is not used a BNC 75 Ohm
terminating plug should be fitted on the unused
connector. 

This input and the signal format is selected using the
front panel controls.

CVBS G/Y B/Pb R/Pr SYNC

INPUTS

88

50

F

B/Pb R/Pr SYNC

INPUTS

R
E

M
O

T
E
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VGA (Computer Input)

Input signals from a computer source should be
connected to the unit using this 15-pin mini ‘D’ type
connector. The connections are compatible with
computers using the same type of connector for IBM
(or compatible) CGA, VGA and SVGA signals.

This input, its usage and the signal format is selected
using the front panel controls.

Pin Connections

APPLE MACOUT

IN

L 

IBM VGA Y/C

1 Red Video
2 Green Video
3 Blue Video
4 Ground
5 Ground

6 Red Ground
7 Green Ground
8 Blue Ground
9 Not Used
10 Ground

11 Ground
12 Not used
13 H-Sync
14 V-Sync
15 Not used

APPLE MAC   (Computer Keying only)

This 15-way, standard density male ‘D’ connector
allows signals from an Apple Mac computer to be
connected to the unit.

Pins Connections

1  Red Ground   6  Green Ground 11  Sync Ground
2  Red Video      7  Mode            12  V-Sync
3  N/C 8  N/C                13  Blue Ground
4  Mode 9  Blue Video     14  Sync Ground
5  Green Video 10 Mode            15  H-Sync 

APPLE MACOUT

IN

L 

IBM VGA Y/C

SECTION 3
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WARNING
As the VGA and APPLE MAC  computer
input connectors are connected in parallel,
only one of these connectors should be
used. Under no circumstances should
connections be made to both of the
connectors at the same time.

VGA Keying with APPLE MAC’s

The SuperVisor supports 3 APPLE MAC rates,
640 x 480 (13"), 832 x 624 (16") and VGA  emulation.
APPLE MAC’s  read status lines from the monitor
on reset (only) in order to determine their output rate.
In order for the SuperVisor to imitate an APPLE
MAC monitor LK1 and LK2 must be set as shown
opposite. (Remove top cover for access)
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Alternative methods include powering-up the MAC
with a monitor connected to set the MAC  into the
correct output standard and then reconnecting the
MAC  to the SuperVisor. When the MAC  is emulating
VGA then the SuperVisor will have to set to the relevant
VGA outputs. This mode does however give the capability
of inputting MAC  into the SuperVisor. 

REFERENCE (Analogue)

Note that currently this analogue input does not support
higher rate line and field signals. For such signals, e.g.
from another SuperVisor unit, the Digital reference input
should be used. 

The unit and its output signals may be reference locked
to an external analogue (black burst or composite video)
signal using the ‘REF’ connector. This input expects a
standard level signal and terminates in 75 Ohms.

This input and the signal format is selected using the
front panel controls.
Note that any reference signal supplied must be
compatible with the selected output scan rate standard.

HDTV Input Option

When this option is fitted, this connector is used to
process the Tri-Sync signals contained in the GREEN
signal which should be looped-through the G/Y input.

REFERENCE (Digital)

The unit and its output signals may also be reference
locked to an external digital source (e.g. another
Supervisor unit) via this 9 pin ‘D’ connector marked
‘IN’. TTL horizontal and vertical drive signals are
used, which may be positive or negative going.

This input is selected using the front panel controls.

The 9 pin ‘D’ DIGITAL REF OUT connector provides
outputs of TTL horizontal and vertical drive signals at
ALL times.

The output signal format is selected using the front
panel controls and pin connections are as follows:

1 Ground 
5 H-Sync  
4 V-Sync

All other pins are unused.

MONITORREF

R/PrB/PbG/Y

DEO

SYNC/HD VD

APPLE MACOUT

IN

DIGITAL 
REF

IBM VGATOR
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OUTPUT CONNECTIONS

COMPONENT OUTPUTS

Component RGB or YPbPr outputs are available from
these  BNC connectors at 75 Ohms impedance.

For RGB signals 

Use G/Y connector for Green output signal 
Use B/Pb connector for Blue output signal
Use R/Pr connector for Red  output signal 

Signal levels are non-composite 0.7V p-p into 75
Ohms. Syncs may be added to the green channel
using the Output Format menu and to the Red and
Blue channels by means of a jumper link LK5 
(see ‘Preset Control Functions’)  

For YPbPr signals

Use G/Y connector for Y output signal 
Use B/Pb connector for U output signal
Use R/Pr connector for V output signal 

Signal levels are non-composite 0.7V p-p into 75
Ohms. Syncs may be added to the Y channel using
the Output Format menu and to the Pb and Pr
channels by means of a jumper link LK5 
(see ‘Output Signal Format’ Section 4, Operation)   

MONITOR OUTPUT

The same component signals detailed above are also
available from this 14-pin connector which is suitable
for connection to specific projector displays.

Pin Connections

1 Ground 6 B/Pb output 11 R/Pr output
2 HD/Sync 7 Ground 12 N/C
3 N/C 8 Ground 13 N/C
4 N/C 9 G/Y output 14 VD
5 N/C 10 N/C

MONITORREF

R/PrB/PbG/Y

VIDEO

SYNC/HD VD

OUT

IN

DIGITAL 
REF

MONITORREF

R/Pr/Pb
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SYNC/HD OUTPUT

This BNC connector provides an output of either
standard mixed syncs or Horizontal Drive, positive or
negative going, selected using the front panel controls.

The output  may be an analogue signal for 75 Ohms
or a TTL compatible signal, selected by internal links.

For more details see Output Signal Format, Section 4
‘Operation’

VD OUTPUT

This BNC connector provides an output of vertical
Drive and may be either positive or negative going,
selected using the front panel controls. 

The output  may be an analogue signal for 75 Ohms
or a TTL compatible signal, selected by internal links.

For more details see Output Signal Format, Section 4
‘Operation’

MOREF

R/PrB/PbG/Y

VIDEO

SYNC/HD VD

REF

RB/PbG/Y

VIDEO

SYNC/HD VD

R
O

LL
C

A
LL
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SETTING UP A MULTIPLE SUPERVISOR INSTALLATION

In this system all SuperVisor units
are genlocked together using the
Digital Reference signals.

Unit No.1 could operate in the
free-run mode or could be
genlocked to an analogue
reference signal or to the Video
Input signal using the IO Lock
function. Unit 1 then provides the
master reference signal for the
other units.

Note that as the Digital Ref.
In/Out is an active loop-through
an unlimited number of units may
be connected together in a chain.
The Video Input however, uses a
passive loop-through system and
if more than 4 or 5 units are
connected together in a chain it is
possible that a small amount of
picture degradation may be
observed. 
Under these circumstances it is
recommended that VDA’s are
used to provide separate drives
for each group of SuperVisors.
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TIPS ON HOW TO USE YOUR SUPERVISOR

The Supervisor is a very versatile tool, it was conceived to enable Audio Visual professionals to improve or
optimise video pictures for projection. This guide is intended to enable you not only to take advantage of the
Supervisor’s wide ranging capabilities, but also to achieve the best from the display device and picture sources
that you have. Although throughout this guide we refer to projectors, the Supervisor will work with any display
device, and most of the principles presented here are equally relevant to whatever technology is being used.

Please note that this is only a guide based on good video practice. To achieve the best results it will be
necessary for all elements in the video chain to be working well. The lowest quality part of the chain will
determine the final image quality, be that the original picture source, playback mechanism, projector, screen or
projection environment. So use the guide to assist you to achieve ever better video pictures, that is after all
what the Supervisor is all about.

Projector Types

There are several predominant projector technologies on the market, each type has advantages and
disadvantages, and each type can have favourite settings for best results. The flexibility of Supervisor makes it
possible to optimise these settings. Video projectors have in recent years become more flexible in line and field
rate, often able to display HDTV and computer graphics in addition to regular video. It is important to chose the
right projector for the job required, since there are many manufacturers of projectors on the market all
promoting their various technologies.

CRT Projectors

CRT Projectors are available from many companies in a very wide range, they have been around the longest
and come in three main categories.

Regular

525 and 625 inputs only, now only really used at the bottom end of the market. Often the lens quality is poor.
N.B. This type will not work with Supervisor.

Multiscan

The current favourite, multi-scan projectors have a wide line and field rate range to allow use on computers as
well as regular video. The difference in cost between the cheapest and most expensive is mostly in the optics
and CRTs. Brightness is often traded for Sharpness or vice versa. CRTs are normally on the small side for best
results with widescreen 16-9 pictures.

HDTV

Mostly considered too expensive but these are the best to use if possible. They may need stacking to increase
the light output. HDTV projectors normally have large 9" or 12" tubes, magnetic focus (very important for sharp
focus over the whole screen) and very good quality all glass or glass plastic hybrid lenses with liquid coupling
for a higher contrast ratio. Most HDTV projectors are available with multi-scan facility but some have a scan
frequency range limited by the magnetic focus.

CRT Projectors are amongst the easiest to install and have the lowest running cost. They are by far the most
common type of video projector.

Oil Light Valves

These are professional projectors used for very large screens with a lot of light output. These are normally
installed by professionals and are used a lot in NASA type control rooms. Often used at televised awards
ceremonies or beside the stage at pop concerts. They are available in multi-scan and use special Anamorphic
lenses for widescreen
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ILA Lightvalve

ILA CRT/LCD projectors have been around many years in the large control room screen area. Recently
improvements to the LCD dynamics have made them suitable for moving pictures. They have a lot of light
output and can project onto a large screen. Black level on some models is not quite black. The gamma tracking
is sometimes poor when the ILA bias is adjusted for minimum pattern visibility, the Supervisor gamma corrector
allows the gamma to be brought back to normal.

LCD Lightvalve

The LCD lightvalve is the current hot shot although picture quality is very variable. In a few years time this will
almost certainly be "The" technology until semiconductor mirror projectors become available.

Currently look out for low pixel count (low resolution), LCD lag or smear, not quite black black level, defective
pixels, poor gamma tracking and beat patterns on moving pictures.

DMD (Digital Micromirror Device)

This is a new form of projector which uses reflective mirrors on a silicon chip to reflect the light beam through
the output lens. They have great potential for the future, although at the time of writing only a few development
models have been shown. One potential problem could be the visibility of grid lines caused by the gaps
between the mirrors and a stepiness on smooth graduations, this aside the technology offers several
advantages over some current projector types and is definitely one to watch.

Laser

Laser projectors are very specialist and are used for mainly long throw applications for very big screens or
projecting on to, for instance, water fountains. They have almost infinite depth of field resulting in perfect focus
on any object in the beams path.

As a guide please try the following Supervisor settings to start with. These settings should compliment the
particular projector types, but we would always recommend experimentation since there are many factors that
can affect perceived picture quality.

CRT Projectors 2 x H or 1.5 x H/1.5 x V.
Oil Light Valve 2 x V or 2 x H.
ILA Light Valve Non Interlace or 2 x H.
LCD Light Valve Depends on internal scan rate adapter. Experiment.

Where H = Number of scanning lines in the picture.
V = Number of pictures per second.
1-1 after the H and V number indicates non interlace or progressive scan.
2-1 after the H and V number indicates interlace.
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Basic Issues of Projection

There are several important issues when deciding how to set up a projector. The two most important are
viewing distance and contrast ratio (often confused with brightness).

Viewing Distance

The standard way throughout most of the world to describe projector size is to give a figure denoting the size of
the projection diagonal in inches. The width and height for any diagonal size of the screen depends on the
aspect ratio required.

The standard way to decide how far away from the screen to seat the audience is to multiply the screen height
by a ratio dependent on the Video format used. In practical terms the screen height to audience position ratio
depends on the resolution and quality of the original material and the scan rate used for projection. The simple
guidelines below can be used as the minimum distance for good quality pictures. The minimum distances may
be too close for audience comfort however.

Using 1050,1125 or 1250 lines the line structure will become visible at about 1.5-1.8 H. (H = screen height)
e.g. Screen height 6 feet. Distance from screen to audience 6 x 1.5 = 9ft.

For super sharp digitally mastered HDTV pictures 2-2.5 H.For intermediate HD (Unihi Etc.) 3 - 3.5 H (Normal
for HDTV viewing). For Low end HD or upconverted regular video 4 -4.5H.For regular video 8-8.5H.

Assuming the original picture quality is good, the only downside of being closer than optimum will be a loss of
subjective sharpness. The further away the viewer the less will be the perception of quality or sharpness
difference, although the viewing experience will be degraded.

Contrast Ratio

Contrast ratio is the difference between black and maximum white. The more contrast ratio the more "punch"
and sharpness the picture will appear to have.

Nowadays most video projectors use cinema style screen material. This material commonly has a gain of
around 2.25. This means it reflects 2.25 times more light than the reflection standard. (The reflection standard
in the UK is a freshly cut magnesium block). Beware of screens with quoted gains of 5 plus. They will either
use a dirty dish towel as reference or be designed for specialist application and be too directional.

The lower the gain of the screen the lower the light output. The higher gain screens have the advantage of a
higher light output but have the disadvantage of a small viewing angle. (People at the sides or above and
below the optimum position see a dimmer picture). The higher gain screens also suffer more from colour
shading when used with projectors having separate Red, Green and Blue channels.

Getting back to contrast ratio, it is commonly perceived that the brighter the picture the greater the contrast
ratio, this is only partly true. Contrast ratio is the ratio between Black and peak White.

It is extremely important to ensure that the blacks are black. Ambient light reduces contrast ratio severely, the
higher the screen gain the more severe is the contrast degradation. There is little point in having a several
kilowatt xenon lamp in the projector if the screen is washed by high ambient light and yet even the most
experienced professionals make this mistake regularly. So unless physical conditions make it impossible such
as at outdoor events, you should always carefully control the projection environment.



APPLICATIONS SECTION 4

SUPOPS141299 Version 2 Issue 4 Software Version 7.0 Onwards 4.4

Set up tips

Mechanical Positioning

Projectors with colours coming from different origins need to have each colour overlaid one on the other. This
is called convergence or registration.

Modern projectors have extensive remote controls with electronic correction to make this possible. There is
however a down side. This is that the more electronic correction used in the scanning mechanism the more
likely the registration is to drift. To minimise this drift the projector should be precisely aligned physically to the
manufacturers specifications.

The simplest way to check the position of the projector for the correct horizontal axis is with a piece of cord. Tie
an end of the cord to each side of the screen. Then tie a knot in the cord, so as to form a "V" with each leg of
the V precisely the same length. The V cord is pulled back over the body of the projector until the legs of the V
pass over the front left and right corner of the projector. Adjust the knot position until the cord crosses the
projector corners as above.

The projector is now moved until it is dead centre with the screen and at 90 degrees to the screen horizontally.
The knot forming the root of the V can be moved in or out for different projector screen distances. The vertical
position should be checked with height measurements and an inclinometer. Following this mechanical
adjustment the projectors mechanical focus should be adjusted as should any tube lens assembly adjustments,
if the screen size has varied from the previous set up.

Electrical Set up

When adjusting the Set up electronically all "zone/area" correction should be erased or pre-set as should size.

Spend as much time as possible setting the projectors basic adjustments such as size, position, keystone and
pincushion before moving to zone/area. If factory pre-set size does not match the screen try moving the
projector in or out slightly.

With CRT projectors it is worth lowering the contrast and looking into the green lens to set the scan size as big
as possible without distortion. Take great care when doing this as the tubes are very bright. Never do this with
any other type of projector as eye damage may result.

All projectors need some warm up time before becoming stable. There is a combination of electronic and
mechanical drift that takes maybe 1-2 hours to stabilise. Some CRT projectors have problems with electrostatic
charge travel along the CRT’s. This may take as much as 7 hours to stabilise, causing convergence drift.

If the power is interrupted the charge dissipates and the drift starts from the beginning. It is always worth
putting the projector on a continuous supply and taping the connectors to stop cleaners unplugging the
projector to plug in their vacuum cleaner, 10 minutes before your major client arrives.

If you are using an HDTV projector for the first time it is easy to stop optimising the line up when it looks a bit
better than a normal projector. You will find however that it is well worth spending more time, as true HDTV
projectors can look awesome.
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Picture Set up

Picture set up is often carried out carelessly or not optimised for the programme material to be shown. Using
the above guide and Supervisors wide selection of test patterns it is possible to get the best out of the picture
source. Below is a suggested procedure for set up and alignment.

Set the Output rate to that which will best compliment the display device. If using the computer keying features
then this output will be limited to the computer rate that is used.

Select Patterns on. Select the Crosshatch pattern from the Patterns menu. Using this pattern or else the
projectors in built convergence patterns, correctly converge the projector. The usual sequence is to start with
the green gun as near to its centre default position as possible, then to converge red to green, then blue to
green. Whilst doing this it may be a good idea to turn the brightness and contrast down so that the crosshatch
patterns appear as fine lines.

Set the Gamma adjustment to 0, this is in the Filtering menu, Select Pluge pattern from the Patterns menu. The
Pluge pattern has two important vertical bars in the left part of the picture. The left vertical bar is just above
black level and the right vertical bar is just below black level. Adjust the projector brightness until the left bar is
visible and the right bar is just invisible. You may wish to set up the picture slightly to adjust the colour and then
reset. It is extremely important that this adjustment is made in the conditions you will project in. The top white
bar of the vertical grey scale should not be blooming.

Select Step (Gamma) pattern in the Patterns menu and adjust projector contrast until the right hand bar
blooms or has a halo effect. Turn the contrast down until the bloom or halo just disappears. Check if the steps
of the pattern appear to be equal or if they appear to be too close together at the left side (the well known black
crushing). Adjust the Gamma control (Filtering menu) until the steps appear to be equal.

This Step (Gamma) pattern should also appear as a neutral grey, so adjust the individual gun set-ups to
achieve neutral greys on the lower LHS steps and the individual gun gains to achieve neutral whites on the
higher RHS steps. This neutrality test can also be done using the Ramp pattern, and then selecting Mono in
the Effects menu to give a smoothly increasing video level from black to white.

Select the multiburst chart and check for good resolution, this will help to confirm if the convergence is correct.

Finally check the colourimetery with the Bars, and Bars with Red patterns, remembering that these give 100%
colour saturation, which is unlikely to be achieved by any video source, but may be achieved by a computer
source.

It is possible to trade sharpness for brightness (contrast control) on CRT type projectors with RGB drive and
Contrast controls. If it is decided to run the projector at a higher brightness (contrast control) then reference
should be made to the above patterns to see what effect this will have on flare, blooming and colourimetery.
Somewhat confusingly the brightness control adjusts the black level of the picture and the contrast control
adjusts the peak brightness.

Now the projector is correctly aligned to the Supervisor output. Errors in picture levels must now be at the input
to Supervisor, so turn Patterns off and select the video source in the In Format menu. Run all the tapes or
pictures sources and adjust the Procamp controls; Luma gain, Chroma gain, black level etc. to get the best
pictures. These settings can then be stored in the Supervisor memories and recalled for each tape segment
using the Save and Read keys.It is extremely important that as much as possible of this set-up is done in the
same conditions as you will project in.



APPLICATIONS SECTION 4

SUPOPS141299 Version 2 Issue 4 Software Version 7.0 Onwards 4.6

Tape Formats

Different tape formats have different attributes, noisy or consumer tape format programmes are best avoided
for professional presentations.

Below is a list of videotape formats applicable to upconversion in order of preference

D1/D5
Digital Betacam
Betacam/MII
D2/D3
Type B/C/Quad
S-VHS/HI-8 Y/C connected
U-Matic
VHS

Undoubtedly the best results come from component recordings and then the use of component throughout the
chain. Next in order of preference would be to use Y-C connections, and then finally composite.

DVD Players

Commercial DVD material may be copy-protected. Your DVD supplier can tell you if the DVD material can be
supplied without copy protection. DVD material that is not copy protected is the best type of DVD source for the
Supervisor. If you do use copy protected DVD s you will find that the output picture may experience problems
resulting in picture tearing as the DVD copy protection does its job.
�

With a little care and thought and using the above tips you should be able to achieve the best results from your
equipment and picture sources.





FRONT PANEL CONTROLS

GENERAL INFORMATION

The SUPERVISOR may be controlled by means of a
local, front control panel, by a similar panel at a remote
location or a computer interface. Communication is via
a wired network system and several units may be
controlled.

VGA Terminology

The term ‘VGA’ is used throughout  SuperVisor
documentation and in this context is used to describe
all supported computer standards including CGA
(Colour Graphics Adapter), VGA  (Video Graphics
Adapter), SVGA  (Super Video  Graphics Adapter)
and MAC (Apple Macintosh) computers emulating
VGA scan rates.

THE CONTROL PANEL

All operational parameters and selections are made
using a system of menus displayed in two LCD
windows. These are labeled INFORMATION and
CONTROL.

Menus are selected by push buttons and further menu
selections made by rotating a spinwheel and pressing
a push button. 

The spinwheel also allows continuously variable
parameters, e.g. Luma Gain, to be adjusted and the
setting to be seen in the LCD window. 

The Display Select buttons allow the spinwheel
action to be applied to either the Information or the
Control window. 

Various specific operations may be achieved by
operating dedicated push buttons.

The Menu System 
(See ‘Supervisor Menu System’ drawings opposite)

The system may be considered structured as a set of
menus and sub-menus which are displayed in the
central LCD window. The Information window will
display the current input/output standard selections of
the unit and information messages. (e.g. Signal Loss,
Genlock Loss)  

The highest level menu is called the Select Menu and
contains the names of the lower-level menus which
may be scrolled through using the spinwheel. 
The sub-menu may be then be selected by pressing
the push button adjacent to the arrowhead in the text
line of the menu name. This sub-menu will then be
displayed in the window and will have the option of
selecting another sub-menu in the same manner, or
allow the adjustment of a particular parameter.
Parameters enabled will appear as highlighted reverse
text (white text on a black background)

This LCD window
displays the current

input/output standard
selections, information
and error messages

This LCD  window
displays the

parameters and
sub-menus that may

be selected by the push
buttons and by the

spin-wheel

The spin-wheel
allows

parameters and
menus to be

displayed in the
LCD window

Display
Control
Buttons

Dedicated
Function 
Buttons or

multiple unit
control

functions 
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3-LEVEL MENU SYSTEM

Uniquely, the SuperVisor has three menu systems
available to the operator. 

The menu system at Engineering and SuperVisor
level contains all available SuperVisor functions and
the system at User level  contains a simplified set of
functions optimised for easy every-day operation.

These menu systems are shown opposite page 5.1 

Selecting the Menu Level

1 Power-down the SuperVisor unit 

2 Hold down the SAVE button, power-up the unit
then release the SAVE button. (Note that the
menus will only be loaded when the button is
released)

3 When the menus have been loaded press the
SAVE button. 
A front panel menu will appear in the control
window instead of the SAVE menu and the
information window will display Setup Options 

4 Select ACCESS LEVEL from the menu

5 By rotating the spinwheel select either the
Engineer or User setting from the displayed
sub-menu

6 Save this setting

7 Power-down and power-up the unit; the front
panel will now offer the new set of menus

USING THE DIFFERENT LEVELS

The  Engineering level should be used to set up basic
parameters of the unit that would not be available in
the User level.  
e.g. Input Scan Rate, Output Format, Genlock
Functions etc.   

When these parameters have been set up the User
level can be accessed and the new menus used to
control a simplified set of functions.

Backlight...
Network...
Access Level..
Version...

CAUTION!

Do not attempt to select or change any other
settings in the front panel menu.
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GENERAL INFORMATION

If a menu title is followed by three dots
e.g.Genlock...
this indicates that a further sub-menu is available for
selection. 

Pressing the Home button will display the Select
Menu in the control window from any position in the
menu hierarchy.
The Previous button allows a return to the last menu
that was changed.  Up to 20 changed menus may be
retraced using this function. 
The Return button  will allow access to the previously
selected upper-level menu.

When the Scroll LED is illuminated this indicates that
a menu contains more than four text lines and the
spinwheel may be used to scroll through the menu.
When the Adjust LED is illuminated this indicates that
parameter values and alpha-numerics may be
changed.
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THE LCD DISPLAY WINDOWS

Control Window

The control window displays all Selection Menus and
sub-menus. An example is shown opposite.

The selection is made by pressing the button adjacent
to the required item and will become highlighted
(reverse text) when active.

Information Window

The information window has four lines of text indicating
current selections and various messages.

The first line shows the current selection made from
the Input Scan Rate Menu or the currently selected
output pattern.

The second line shows the current selection made
from the Output Standard Menu.

The third and fourth line displays information and error
messages.   

The example opposite indicates that the selected input
standard is 625 line, 50Hz field rate, interlaced 2:1  the
selected output standard is 875 line 75Hz field rate,
interlaced 2:1 and  that  the unit is not receiving an
input signal .  

The window may display the following error messages:

Freeze-SYNC LOSS 
This indicates that the unit is not receiving an input
signal or that the input signal sync level is below
100mV p-p

- - GENLOCK LOSS - -
This indicates that the unit is not receiving a reference
input signal or that the reference input signal sync level
is below 100mV p-p

Note that if both input and reference signals are lost
the SYNC LOSS message will have priority and will be
displayed.

Information messages such as - - Preset - - will appear
in the third line when the function is selected but will
only be displayed for approximately 5-10 seconds. 
If an error condition exists the error message will then
be displayed; otherwise the line will become blank.

Filtering...
VGA Key...
Genlock...
Memsave...

Size...
Effects...

System...
MemRead...

In:    625 50 2:1
Out: 875 75 2:1          
Freeze-SYNC LOSS
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USING THE MENU SYSTEM

This example describes how to select the input and
output rate and then change the output picture width
(Horizontal Size) using the menu system.
An input signal with a scan rate of 625 lines, 50Hz
interlaced 2:1 is assumed, driving a suitable
multi-monitor at a scan rate of 625 lines, 50Hz,
non-interlaced.

Ensure that the Select Menu is shown in the control
window. If not press the return button until the menu is
shown.

Rotate the spinwheel, if necessary, to reveal the
In Rate... text line. 

Press the button next to In Rate... to reveal  the Input
Scan Rate Menu.

Rotate the spinwheel, if necessary, to agree with the
drawing opposite.

Select either Auto std detect or 625 50 2:1

Press the return button to return to the Select Menu.

 In Rate...          Out Rate...
 In Form...        Form Out...
 Patterns...        ProcAmp...
 Filtering...     Size...

 Auto std detect
 625 50 2:1
 525 60 2:1
CGA 320x400 1:1

 Example....Menu Selection 
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From this menu select Out Rate... and the Output
Scan Rate menu will be displayed.

Rotate the spinwheel, if necessary, to reveal  the 
625 50 1:1 text line and press the adjacent button.

Ensure that the information display window now shows
the units system status as shown opposite.

Rotate the spinwheel to reveal the Size... text line in
the select menu and press the adjacent button. 

This will reveal the Picture Sizing Menu.

Press the button adjacent to  Horz Size 

 625 100 2:1
 625 50 1:1
 1250 50 2:1
 875 75 2:1

In:    625 50 2:1
Out: 625 50 1:1            

 Horz Size           Vert Size
 Pan                   Tilt
 Aspect Ratios

 In Rate...          Out Rate...
 In Form...        Form Out...
 Patterns...        ProcAmp...
 Filtering...     Size...

 Example....Menu Selection 
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The control window will now display a bar-graph
showing the current Horizontal Size setting. 

The horizontal size of the output picture may then be
changed to the desired value by rotating the
spinwheel.

To return to the previously set value, the button
adjacent to the Preset arrowhead should be pressed.

This completes the example demonstrating the use of
the menu system.

Pressing the return button will return the central
display to the Picture Sizing  Menu and pressing it
again will return the display to the Select Menu.

All other functions and parameters may be
selected in a similar manner.

Horz Size
1024
 
Preset

 Example....Menu Selection 
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USING THE DEDICATED PUSH BUTTONS

Various specific operations may be carried out by
using these push buttons which provide a short-cut
method to access particular functions.

When pressed the button LED will become illuminated,
indicating that the function is active. Pressing the
button again deactivates the function and the button
LED will turns off.

Selecting a Pattern

Pressing the PATTERN button will display in the
window the currently selected pattern from the list of
test patterns in the Pattern menu. 
(see ‘TEST PATTERN SELECTION’)

Pressing the button again deactivates the function,
and the processed picture will reappear.  

Note that if a pattern has already been selected using
the menu system the words PICTURE ACTIVE will
appear in the window. Either method may be used to
select a pattern but using the dedicated button is a
more direct method. 

Short-Cut to Selecting the Output Scan Rate Menu

Pressing the OUTPUT button will immediately reveal
the Out Rate... menu in the control window. Selections
may then be made in the usual way. (see ‘OUTPUT
SIGNAL SCAN RATE’)

Pressing the button again deactivates the function and
the top level Select Menu will appear in the display
window.

Short-Cut to Selecting the Memory Functions

Pressing the SAVE button reveals the Mem Save
menu in the control window, listing the five memory
locations.
(see ‘MEMORY’ )

Pressing the READ button reveals the Mem Read
menu in the control window, listing the five memory
locations.
(see ‘MEMORY’ )

Pressing the buttons again deactivates the function
and the top level Select Menu will appear in the
display window.

VGA

The VGA Key or Cut  function as specified in the VGA
Key Menu, is toggled ON or OFF with this button.
This has the same function as selecting  VGA KEY
ACTIVE in the VGA Key Menu.

Note that if a VGA Output Scan Rate has not been
selected, the VGA key function will not be available
and the message ‘Select Video→VGA’ will appear in
the information window.

Preset

Pressing the PRESET button  will return the unit and
all settings to a preset condition. The preset conditions
will be the factory default settings except where the
default settings have been changed by the DIP switch
SW3. 

Note that this is not a reset function and all stored
memory information will be retained.

This function is particularly useful for a first-time user
or when the user is uncertain of a previous users
set-up; returning to a preset condition provides an
ideal starting point for configuring the unit to one’s own
preferences. 
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MENU DETAILS

INPUT SIGNAL SCAN RATE 

Pressing the button adjacent to the In Rate...
arrowhead in the Select menu will access a list of input
scan rates.

The first option is for Auto std detect.

Selecting this option will allow the unit to automatically
sense the input signal standard and process it
accordingly.

The unit may be forced to accept a particular input
signal scan rate by scrolling through the menu using
the spinwheel and pressing selecting the required
scan rate. 
Default setting is  Auto std detect (this message will
appear in the left hand window)

Note that if the unit is forced to accept a particular
input scan rate, e.g. 625 50 2:1, and subsequently the
input signal changes to , for example, 525 60 2:1, the
output  signal will become corrupted. If such changes
of the input signal scan rate are anticipated it is
suggested that the Auto std detect. mode be
selected.

When in the Auto std detect mode the information
window will show the standard of the  input signal scan
rate. For example if a 625 signal is connected the
display will show:

Auto - 625

This information is purely dependent on the the input
signal and is automatically detected.

 Auto std detect
 625 50 2:1
 525 60 2:1
 CGA 320x400 1:1

 In Rate...          Out Rate...
 In Form...        Out Form...
 Patterns...        ProcAmp...
 Filtering...     Size...

Note that underlined menu items are only available at
Engineering and SuperVisor levels. Text in brackets
refers to equivalent item (if available) in User level  
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 OUTPUT SIGNAL SCAN RATE     

Selecting Out Rate...  (Output) in the Select menu will
access a list of output scan rates.

The unit can be made to produce a particular output
signal scan rate by scrolling through the menu using
the spinwheel and selecting the required scan rate. 

Producing The Best Quality Pictures

The quality of the final displayed picture can depend
on a number of factors:

1 Input to output scan rate compatibility
2 The actual output scan rate chosen
3 The particular  characteristics of the display unit 
4 Adjustment of the processing controls
5 The type of material contained in the picture

Input To Output Scan Rate Compatibility

Best results will generally be achieved by choosing an
output scan rate complimentary to the input scan rate.
For example, if a user required a greater number of
lines in the output picture (to reduce scan line visibility)
a scan rate of 1250 lines would be chosen to give best
results when the input scan rate was 625 lines rather
than 1050 lines , which would be used with a 525 line
input.  Generally, select the highest output scan rate
that is an integer multiple of the input scan rate.    

The Particular  Characteristics Of The Display Unit

All display devices, especially projection systems,
have their own particular and often unique,
characteristics. 
The SuperVisor has a wide range of output scan rates
available in many formats and it is well worthwhile
spending some time experimenting with various
combinations of output scan rate and format.   

Adjustment Of The Processing Controls

Optimising the Luma Gain, Chroma Gain, Black
Level ,Y-C t iming, Gamma and Sharpness
adjustments can dramatically improve the displaced
picture; again, experimentation is advised.

The Type of Material Contained in the Picture

Specific programme material may benefit from the use
of particular interlace ratios and l ine rates;
experimentation is also advised for a particular
application.

 625 100 2:1
 625 50 1:1
 1250 50 2:1
 875 75 2:1
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INPUT SIGNAL FORMAT

Selecting In Form... (Input) in the Select menu will
access a list of input signal formats.

A particular input  format  and a Syncs sub-menu may
be selected from this list. 

It should be noted that the YPbPr and GBR input
connections share the same BNC connectors on the
rear panel, whereas the composite, YC and VGA
inputs have dedicated separate connectors. 

Note that if an input signal is not present or the sync
level is below 100mV, the information display window
will show
                          Freeze- Sync Loss
and the unit will have automatically enabled the freeze
mode and captured the last previous source picture.   

Note that the syncs options applies only to the
component GBR and YPbPr input signals.

Selecting Syncs... reveals a list of input sync options.
The default selection is Sync on G/Y indicating that
the unit is set up to accept either a GBR signal that has
syncs on the green channel or a YPbPr signal with
syncs on the Y channel. 

Selecting  Ext 0.3V Syncs allows the unit to accept an
input sync level of 0.3V p-p (nominal) at the SYNC
input connector.

Selecting  Ext 2.0V Syncs allows the unit to accept an
input sync level of 2V p-p (nominal) at the SYNC input
connector.

HDTV Option

If the HDTV input option is fitted the Ext HD Sync item
will appear in this menu.

When this item is selected and HDTV signals are being
processed, the GREEN signal (which contains the
Tri-Sync signal) should be bridged through the G/Y
input connectors and connected to the self-terminating
REF input. 

Note that when this selection is made any sync signals
connected to the SYNC or G/Y connector will be
ignored. 

YPbPr           GBR
YC          Composite
VGA       Syncs...

 Sync on G/Y       
 Ext 0.3V Syncs
 Ext 2.0V Syncs
 Ext HD Syncs            
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OUTPUT SIGNAL FORMAT

Selecting  Out Form..  in the Select menu will access
a list of output formats.

The first text line allows either a component YPbPr or
GBR output format to be selected. Default selection is
to GBR.  

Note that the YPbPr and GBR output connections
share the same BNC connectors on the rear panel
whereas the Monitor output has a dedicated separate
connector. 

Output Signal Details

YPbPr Mixed syncs may be added to the Y 
signal using this menu  (see below)
and to the Pb and Pr signals by 
means of  an internal link LK5

GBR Mixed syncs may be added to the 
Green signal using this menu 
(see below) and to the Blue and Red 
signals by means of an internal link 
LK5

Location of Jumper Link LK5

 Out Format: GBR/YPrPb
 Out Syncs:  Normal/Invert
 Sync On G/Y
 Composite Sync            
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The second text line, Out Syncs, allows the sync
polarity to be set to either Normal or Inverted. Default
is to Normal.

The type of output is set using jumper links LK2 and
LK3 on the PCB and may be set to give an analogue
signal (0 to -2V into 75 Ohms) or a TTL compatible
signal (0 to 4V into 1K Ohms) 

          Location of Jumper Links LK2 and LK3

The next text line, Sync On G/Y, allows the sync signal
on the Green or Y signal (0.3V p-p) to turned On or Off.
Default selection is to Off.

The last text line, Composite Sync, selects the type
of signal available at the Sync/HD connector on the
rear panel. The ‘On’ selection produces a mixed sync
signal and the ‘Off’ selection produces an HD signal at
this connector. Default selection is to Off.

 Out Format: GBR/YPrPb
 Out Syncs:  Normal/Invert
 Sync On G/Y
 Composite Sync            

 Out Format: GBR/YPrPb
 Out Syncs:  Normal/Invert
 Sync On G/Y
 Composite Sync            
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TEST PATTERN SELECTION

Selecting Pattern... in the Select menu will access a
list of test patterns available from the unit.

The Pattern mode selection may also be enabled by
pressing the dedicated front panel button marked
‘Pattern’  The pattern will then immediately appear at
the output and the pattern name and ‘pattern active’
will become highlighted in the menu. 

A particular pattern may then be found and selected.
The pattern name will then become highlighted. 
To output the pattern the ‘Pattern Active’ line should
be selected and the text will become highlighted.  
To de-select a pattern the ‘Pattern Active’ line should
be selected and the text will revert to normal.  

When a pattern has been selected the first text line in
the information display window will show:
Pat: (pattern name) instead of  In: (input standard) 

The pattern will have parameters as selected in the
Output Scan Rate and Output Format menus.

Note that the Size, Pan, Aspect Ratio and invert
functions cannot be applied to the internally generated
patterns.

Patterns include:

Colour Bars (100%)For checking Colourimetry 
and Alignment

Bars and Red (100% Bars and 100& Red area)
For checking vertical Y/C delay

Crosshatch For checking registration
Step (10 equal steps) For checking the 

Gamma setup.
Ramp (0 to 100%) For checking linearity. 

(Note that this signal includes a UV 
ramp which may be removed by 
selecting the Mono function in the 
Effects Menu)

Multiburst (2,4,6,8,10,12,14 and 16MHz bursts)
For checking frequency response

Pluge For checking black level (brightness)
and gain (contrast)

Black (0%) For checking black level errors.
White (100%) For checking white level.

Note that for patterns containing vertical information
(Bars and Red, Crosshatch and Pluge) the relative
proportions of the vertical areas will vary slightly
depending on the output standard in use.  

100% Bars
Bars & Red
Crosshatch
Step(Gamma)
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PROCESSING CONTROLS

Selecting ProcAmp... (Video) in the Select menu will
access a list of signal processing functions that may
be controlled. Note that these settings will effect ALL
video output signals where appropriate.

When a function is selected the unit will provide a
display giving the name of the parameter, the
numerical value and the facility to return to a preset
value. The value may be adjusted using the spinwheel
within the limits stated in Section 2, ‘Specifications’

Pedestal

The SuperVisor will automatically, by default, only
remove the pedestal present on 525 line Composite
and Y-C signals.

Note that to comply with SMPTE 170M the pedestal of
525 l ine YPbPr signals wil l not be removed
automatically. 

The Pedestal selection provides the facility to override
this automatic function by selecting ‘Remove’.  
The default selection is ‘Normal’ 

It should be noted that if an input scan rate/format other
than 525/Composite/Y-C is selected, the input signal
pedestal, (if any) will be retained on the output signal
when the ‘Normal’ selection is made.

CAUTION!
If the ‘Remove’  option is enabled under these
conditions, and the input signal has no pedestal, the
black level of the output signal will be set-down. 

Horizontal and Vertical Y/C Delay 

Selecting H-YC Delay  or V-YC Delay will reveal a
numeric display allowing horizontal or vertical Luma to
chroma delay adjustments to be made using the
spinwheel.

NTSC Hue (if Decoder option fitted) (NTSC Tint)

Selecting NTSC Hue will reveal a numeric display (in
degrees) allowing the hue or colour tint of an NTSC
picture to be adjusted by ±20° 

Luma Gain
Chroma Gain
Black Level
Pedestal

 Normal
 Remove

(Contrast)
(Colour)
(Brightness)
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FILTERING

Selecting Filtering...in the Select menu will access a
menu offering the choice of filtering and Gamma
characteristics.

The signal passing through the unit may be
sharpened in both the horizontal and vertical directions
by means of aperture correctors and Gamma
correction may be applied to the signal.

Selecting the characteristic required to be adjusted will
provide a display giving the name of the parameter,
the numerical value and the facility to return to a preset
value.

The value may be adjusted using the spinwheel within
the limits stated in Section 2, ‘Specifications’

 Horz Enh  VertEnh
 Gamma        

Horz Enh

Preset
Enhance: 0dB
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Gamma 

Selecting this option will reveal a numeric display titled
Gamma showing the amount of gamma correction
(expressed as a number) and the facility to return to a
preset value.

The value may be adjusted using the spinwheel to give
various values of black stretch.

In this context Gamma is defined as the shape of the
transfer characteristic between input signal amplitude
and output signal amplitude. Normally the shape is a
straight line with a slope of unity and the output level
follows the input level over the dynamic range of the
signal. i.e. Gain does not change with signal level.

If the shape of the transfer characteristic is changed to
a curve, gain will then change with signal level and can
be arranged to either stretch black parts of the signal
and compress white parts or stretch white parts and
compress black parts of the signal.

Generally the output level is related to the input level
by the equation

Vo = Vinγ

Where  γ = Gamma Value

The Gamma correction values available from this unit
range from 1 (unity) to 0.55 in nine equidistant steps
and is only applied to the Y (Luminance) signal. 
An example of the effects of gamma correction is
shown opposite.

This function is particularly useful for correcting the
non-standard Gamma characteristics of CRT-type
large screen projectors.
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OUTPUT PICTURE SIZE 

Selecting Size... in the Select menu will access a
Picture Sizing Menu offering the opportunity to change
the size and shape of the picture.

Picture at 1:1 Size

Selecting Horz Size invokes a bargraph display
indicating the relative width of the output picture
compared to the input picture.

The width may be reduced by 1.5:1 (as shown
opposite) or increased by 4:1 (as shown below) using
the spinwheel, in steps of approximately 5%
The Preset and default value is 1:1

Note that the bargraph is provided to indicate the
relative reduction (clear bar reduces in length) or
increase (clear bar increases in length) in picture width
from the 1:1 value. 

The Vert Size selection allows the height of the output
picture to be changed in a similar way to the width, as
described above.
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PICTURE PAN AND TILT

When, for example, a particular section of the picture
is required to be placed in a particular area of the
screen the PAN or TILT function may be used.

Note that the Pan /Tilt function is only operational when
the picture size has been changed (increased or
decreased) from the 1:1 value; the picture may then
be moved horizontally or vertically (within the picture
boundaries) to any position on the screen. 

The Pan selection allows the picture to be panned
horizontally by ± 75% of input picture width, in steps of
<100ns.

Picture Size x2 with maximum  Pan Left

Picture Size x2 with maximum Pan Right

Picture Size ÷1.5 with maximum Pan Left
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PICTURE PAN AND TILT cont.

Picture Size ÷1.5 with maximum Pan Right

The Tilt selection allows the picture to be vertically
panned by ± 75% of input picture height, in steps of 2
input picture lines.

The bargraph indicates the type and amount of TILT
(clear bar reduces in length for negative values and
increases in length for positive values)  

 

        
Picture Size x2 with maximum Tilt Up 

                 

        Picture Size x2 with maximum Tilt Down
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PICTURE PAN AND TILT cont.

                Picture Size ÷1.5 with maximum Tilt Up

            Picture Size ÷1.5 with maximum Tilt Down
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OUTPUT PICTURE ASPECT RATIO

The output picture may be displayed with a different
aspect ratio to that of the input picture.

Selecting the Aspect Ratios option in the Picture
Sizing Menu allows various input/output aspect ratios
to be selected from a menu. The selected ratio will
become highlighted in the menu so long as no changes
have been made to the picture size or a Pan/Tilt
adjustment introduced. 

Note that the Size, Pan/Tilt and Aspect Ratio functions
cannot be applied to the internally generated patterns.

Normal will give the same output aspect ratio as the
input

    16:9 Aspect Ratio Picture

16:9-4:3 Side Crop will give an output picture aspect
ratio of 4:3 when the input aspect ratio is 16:9. Some
picture information will be lost on both sides.

16:9-4:3 Letterbox will give an output picture aspect
ratio of 4:3 when the input aspect ratio is 16:9. Black
bars will appear at the top and bottom of the picture
but no picture information will be lost.
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OUTPUT PICTURE ASPECT RATIO

      4:3 Aspect Ratio Picture

4:3-16:9 Curtain  will give an output picture aspect
ratio of 16:9 when the input aspect ratio is 4:3. Black
bars will appear at the sides of the picture but no
picture information will be lost.  

4:3-16:9 Top Crop will give an output picture aspect
ratio of 16:9 when the input aspect ratio is 4:3. Some
picture information will be lost at the top and bottom of
the picture.
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KEYING

This unit will allow a VGA or MAC signal (see ‘Installation’ page 3.4 for connection details) to be keyed over an
analogue video signal.

Note that ‘VGA’ is used here as a generalised term for describing a signal derived from a computer source and
includes CGA, VGA, SVGA and MAC type signals.  

Keying is only possible when all of the following conditions are fulfilled:

1. The output scan rate is set to  the same standard as the VGA input signal connected to the VGA INPUT (see
Output Scan Rate Menu)   Note that this means that keyed pictures are only available in a VGA output format. 

2. A YPbPr, GBR,YC or Composite signal is selected (see Input Format Menu) DO NOT select the VGA option
from the Input Format Menu.

3. A VGA signal is connected to the VGA input connector. The unit is designed to automatically genlock to this
signal when any of the active VGA Key Options are selected (see VGA Key Options Menu) and will override the
Genlock On/Off function in the Genlock Menu. Note that the unit will remain genlocked to the VGA signal (even
when the active VGA Key Options are de-selected)  until either the output standard is changed (the unit then
reverts to the previous genlock selection) or the genlock function is turned off. 

SELECTING THE KEY FUNCTION

The Key function may be directly selected by pressing
the dedicated button on the front panel (toggles Key
ON or OFF) or from the VGA Key menu and selecting
‘VGA Key Active’

SETTING UP THE KEY PARAMETERS

When the VGA Key... option is selected from the
Select Menu, the VGA Key Options Menu will be
revealed. 

The options are:      VGA MODE: WIPE OR KEY

Wipe (to deselect, select Key)
When Wipe is selected output picture may be split into
two sections; one section will contain the analogue
picture and the other section will contain the VGA
picture. The size and position of the section may be
adjusted vertically and horizontally using two Wipe
Adjust and Wipe Invert fuctions selected from the
menu.

Key  (to deselect, select Wipe)
This function keys the VGA picture into the analogue
picture. The key signal is derived from the VGA picture
by summing the red, green and blue signals and then
passed to a threshold detector.  
When this signal is above a particular level the VGA
picture is displayed and when the signal is below that
level the analogue picture is displayed. The level at
which the change occurs is set by the Key Threshold
control.
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Vert Wipe Adjust
Selecting this function will reveal a bargraph showing
the position of the vertical split point separating the two
picture sources. This split point may be adjusted so
that either more or less of either picture, in the vertical
direction, is revealed.

Horiz Wipe Adjust
Selecting this function will reveal a bargraph showing
the position of the horizontal split point separating the
two picture sources. This split point may be adjusted
so that either more or less of either picture, in the
horizontal direction, is revealed.

Vert Wipe Invert
When this function is enabled the area of the wiped-in
picture, in the vertical direction, is changed from the
lower part of the main picture to the upper part of the
main picture. 
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Horz Wipe Invert
When this function is enabled the area of the wiped-in
picture, in the horizontal direction, is changed from the
left hand side of the main picture to the right hand side
part of the main picture

Key Threshold
Selecting this function will reveal a bargraph showing
the level of the key signal that is used to determine the
point at which the decision is to display either the VGA
picture or the analogue picture. 
The preset default level is set at 50% and can varied
between 0 and 100%

Note that as the key signal is derived from a summed
G+B+R signal, keying from individual colours is not
possible.

Full Key Invert
In both Wipe and Key modes this function reverses
the areas occupied by the VGA and the analogue
picture. In the Wipe mode for example, in the picture
opposite, the VGA source would now occupy the major
part of the screen and the analogue source will occupy
the minor part of the screen. In the Key mode, high
levels of VGA signal will now reveal the analogue
picture.

When the Key or Wipe  function is enabled it may be
toggled between On and Off by using the dedicated
front panel button marked ‘VGA’
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EFFECTS

Selecting Effects... in the Select menu will access a
Video Effects Menu listing various effects that may be
applied to the output picture.
The functions may toggled ON or OFF.

Freeze will produce a frozen picture. 

Mono Turning this function ON will remove all colour
from the output signal producing a pure monochrome
picture. 

Invert When this function is turned ON the polarity of
the video signal is changed from positive to negative.
i.e. Black becomes white and white becomes black.

Video Wall Shape 

Selecting this function enables the SuperVisor to be
used as a single channel video wall cube controller.

The image from the unit may then be divided amongst
multiple projectors or other display devices which
make up a very large screen display system.

The Video Wall Shape menu lists the various wall
shapes that may be accommodated by SuperVisor.

Examples of the numbering format are given opposite:

One SuperVisor will drive a single cube (a cube is a
individual projector or display device) 

First the relevant Wall Shape should be selected and
then the Cube Select  menu should be selected. 
The value set in this menu determines which cube the
particular SuperVisor unit is controlling.  

Note that the ‘Cube 0’ selection (Preset value) is used
when only one display device is to be driven.  

If a cube identification number other than zero is set in
this menu the unit will automatically size the image to
suit the wall shape defined in the Wall Shape menu.
Fine picture alignment adjustments may then be
made, if required, using the picture sizing controls 
(e.g. Size, Pan and Tilt) 

Note that if a new Wall Shape is selected the Cube
Ident number must be changed to suit the new shape.

Fore more information on multiple systems refer to
SECTION 3, INSTALLATION.

Freeze
Mono
Invert
Video Wall Shape

1H x 2V
1H x 3V
1H x 4V
2H x 1V

Cube Select

Preset
Cube 0
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GENLOCK

The unit can genlock to either an analogue video/black
burst signal (see note below), a digital signal or a VGA
input.

Selecting Genlock... in the Select menu will access a
menu listing various genlock options.

Off  Selecting Off disables the genlock function and
the unit free-runs using the internal SPG; however,
when a VGA Key mode is selected the unit is forced
to genlock to the VGA input. (see ‘KEYING’)

GLK

Whenever the genlock mode has been enabled the
information display window will show GLK in the lower
right hand corner. It should be noted that this indication
does not necessarily mean that the unit is genlocked
to a reference signal; it only indicates that the genlock
mode has been enabled. 

Reference When this mode is selected the unit will
genlock to an external reference signal subject to the
following conditions:

1. The unit will automatically genlock to the reference
input appropriate to the selected Output Scan Rate. 
In practice this means that for most output scan rates
the genlock reference signal will be derived from the
Analogue Reference input connector but when VGA
type output scan rates are selected (especially when
the VGA Key function is enabled) the genlock
reference signal will be derived from the VGA  input
connector.  

2. The unit will genlock to the reference input only if
the selected Output Scan Rate is compatible with the
reference signal; if this condition is not met a corrupted
or blank picture will be displayed. 

3. If the HDTV Input option is fitted and the Ext HD
Sync item selected, the REF input becomes the SYNC
input, processing the Tri-Syncs contained in the HD
GREEN signal.

Note that currently this analogue input does not
support higher rate line and field signals. For such
signals, e.g. from another SuperVisor unit, the Digital
reference input should be used. 

Digital Selecting this mode forces the unit to genlock
to the H-Sync and V-Sync TTL signals from the ‘Digital
Reference In’ connector.

Note that these signals must be compatible with the
selected Output Scan Rate; if this condition is not
fulfilled a corrupted picture may be displayed.  
If a signal is not available at the selected reference
input the information display window will indicate 
- - GENLOCK LOSS - -

Genlock H Phase If a fully compatible reference
signal is available and the genlock mode enabled,
selecting this function will reveal a bargraph showing
the horizontal timing difference between the reference
signal and the output signal. The timing may be
adjusted using the spinwheel to give an advance or a
delay of up to 1600ns. 

The preset/default value is zero.

Genlock-V-Phase If a fully compatible reference
signal is available and the genlock mode enabled,
selecting this function will reveal a bargraph showing
the vertical timing difference between the reference
signal and the output signal. The timing may be
adjusted using the spinwheel to give an advance or a
delay of up to 4 lines. 

The preset/default value is zero.

Off
Reference
Digital
Genlock H Phase

         GLK
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SYSTEM

Selecting System... in the Select Menu provides a
menu listing various system parameters. 

Preset Unit

This performs the same function as the PRESET
dedicated front panel button.This does not clear
memories. 

Clear Mem

This clears data stored in all Memory locations.

VHS Mode

Turning this function ON will introduce a shorter time
constant into the input sync separator phase-locked
loop. This enables the input circuitry to precisely follow
the timing of a jittery signal that would come from, for
example, a VHS video tape playback machine that is
not timebase corrected. 
The function may be toggled ON or OFF.
Default is to OFF

IO Lock: Auto/Off

IO Lock forces the output scan rate to lock to the input
scan rate whenever the in/out scan rates are related
by a multiple or sub-multiple of each other.
For example, an output scan rate of 1250/50 will lock
to an input scan rate of 625/50 (IO ratio of 1:2) but not
to a SVGA 800 input scan rate (IO ratio of 1.12:1)

This function can be set to either IO Lock: Auto or to
IO Lock: Off and is a system wide setting.

When in the Auto mode IO lock will be ON or OFF
depending on whether or not the following conditions
are met:

⋅ A component  input is selected (GBR/YPbPr)
⋅ In/Out scan rates are a multiple of each other
⋅ VHS Mode is set to OFF
⋅ Genlocking is inactive

If any of the above conditions are not met the unit will
operate in the free-run mode; i.e. not IO locked.

When in the Off mode the unit will never IO lock. This
mode could be used when processing a component
source which is unstable e.g. a VTR signal without
timebase correction.

Preset Unit
Clear Mem
IO Lock: Auto/Off
Software Version
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Software Version

Selecting this function will display a message in the
Information window indicating the software revision.
(available from version 3.1 onwards)

Unit Name

Selecting this item will display the name of this unit in
the control  window. This name is used in the
RollCall  system and is supplied set as ‘SuperVisor’

This name may be changed by the user to an
alpha-numeric string of a maximum of 14 characters
including spaces. 
This useful feature allows a unit to have a name more
specific to an application 

e.g. SVGA Processor, Projector No.1 etc. 

or, in a multiple system, to ease unit identification 
e.g. Top Projector, LHS Projector, Cube 1, Cube 2 etc.

When the text line is selected, the first character of will
be in reversed flashing text; this character can then
be changed by rotating the spinwheel. When the
desired character is found the button to the left or right
of the text line should be pressed and the next text
character will be highlighted and available for
changing. The buttons to the left and right of the text
line may be used to select other characters. 

To save the new text, press the OK button. It should
be noted that this is the only way to save the new text
as any other button function will return to another
menu without  modifying the original text. 

Note that to remove a character and leave a clear
space in the text line the Clear function (above Preset)
should be used. 

The Preset function returns the text to the type name
of the module installed in the relevant slot.

Ver 4 Compatible

Selecting this function makes the Version 5 remote
control software in this unit look like Version 4
software to enable equipment fitted with Version 4 to
operate.

IO Lock: Auto/Off
Software Version
Unit Name
Ver 4 Compatible
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MEMORY

The SuperVisor contains a non-volatile memory that
can store all settings in 5 memory locations.

Note that if SW3 position 8 is set to ‘Memory Disabled’,
no memory functions will available including the
restoration of the power-down settings on power-up. 

Selecting Memory Save... in the Select Menu will
access a menu listing the 5 memory locations.

To Save the current settings, press the push button
adjacent the desired memory location number.

Selecting Memory Read... in the Select Menu will
access a menu listing the 5 memory locations.

To Read the current settings, press the push button
adjacent the desired memory location number.

Note that normally on power-up the settings at
power-down will be automatically restored.

Filtering...
VGA Key...
Genlock...
MemSave...

Size...
Effects...

System...
MemRead...

Save 1
Save 3
Save 5

Save 2
Save 4

Read 1
Read 3
Read 5

Read 2
Read 4
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PCB MODULE CONTROLS

On the front edge of the card fitted in the unit there are a number of preset controls, indicators and switches. 

To access these controls the front panel should be pulled forward and lowered.

LED INDICATORS

Power Supply +5V Green ON=OK
+6V Green ON=OK
- 6V Green ON=OK 

Input Signal Sync Loss Red ON=No sync, OFF=Signal Present

Genlock Signal Loss Red ON=No Ref signal, OFF=Ref Signal Present or ‘Genlock’ selected

Data Received Yellow

Data Transmitted Green

CONTROLS

RS485/422 Allows remote communication signal to be set to either RS485 (RollCall )
or RS422  (PC) Supplied set to RS422.

Unit Address Code These Hexadecimal switches set the unit address code

Options Various Preset options may be set using an 8-way DIP and a HEX switch

Note that the following controls ARE FACTORY CALIBRATED and should not be adjusted unless the unit is
fitted with a dumb front panel and level adjustments are required.

Luma Gain Allows Luminance gain to adjusted by ±3dB

Black Level Allows Black Level to adjusted by  ±50mV

Chroma Level Allows Chroma Gain to adjusted by  ±3dB
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POWER SUPPLY INDICATORS

Three green LED indicators (D2,D3 &D4) are provided
to show the status of the internal +5V, +6V and -6V
power supplies.

If any of the LED’s are not illuminated the unit should
be switched off immediately and the unit referred to a
qualified service area.  

INPUT SIGNAL SYNC LOSS

This Red LED (D6) will become illuminated if the unit
is not receiving an input signal at the selected input
connector or if the sync level of the input signal is less
than 100mV p-p 
Note that under these conditions the front panel left
hand display window will indicate ‘Signal Loss’ 

GENLOCK SIGNAL LOSS

This Red LED (D7) will become illuminated if the unit
is not receiving a reference input signal at the selected
genlock source connector when the genlock function
is enabled or if the sync level of the reference input
signal is less than 100mV p-p
Note that under these conditions the front panel left
hand display window will indicate ‘Reference Loss’ 

SECTION 5

 Operation 

SUPOPS251096 SNELL & WILCOX 5.33



COMMUNICATIONS MODE SWITCH

The toggle switch SW1 allows the type of communication
signal used for the rear panel comms ‘D’ connector, to
be selected.

This switch should be set to the UP position for RS485
RollCall  and DOWN for RS422 PC interface signals.

The unit is supplied with this switch set to the DOWN
(RS422 PC) position.

FRONT PANEL CONNECTOR

The connector CN5 is used to connect the PCB to the
active front panel.

LUMA GAIN

The preset control RV6 allows the video gain of the
input signal to be adjusted over the range of  ±3dB.

Note that this control is factory set to 0dB and should
only be used if a passive  front panel if fitted and level
adjustments are required. 

The GAIN should set using the main front panel
controls.
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BLACK LEVEL

The preset control RV7 allows the output signal black
level of the PCB module to be adjusted over the range
of  ±50mV.

Note that this control is factory set to 0mV and should
only be used if a passive front panel if fitted and level
adjustments are required. 

The BLACK LEVEL should set using the main front
panel controls.

CHROMA GAIN

The preset control RV9 allows the chroma gain of the
input signal  to be adjusted over the range of  ±3dB.

Note that this control is factory set to 0dB and should
only be used if a passive  front panel if fitted and level
adjustments are required. 

The CHROMA GAIN should set using the main front
panel controls.

UNIT  ADDRESS CODE

The  HEX switches SW1 and SW2 are used to define
the Unit  Address code for the equipment. They are
only read at power-up. 

Position ‘0’ on the SW2 will disable the RollCall
function on the unit.

Note that if SW2 is set to ‘0’ this will be read as  ‘1’
i.e. values ‘01’ to ‘0F’ will read as ‘11’ to ‘1F’

The minimum address code allowable is 10HEX
(SW2=1, SW1=0) and is shipped with the code 14HEX
(SW2=1, SW1=4) 

All positions above 10HEX may be used to set the unit
address code in Hexadecimal. (SW2, 0 to F, SW1,  0 to F)

If a code is already in use, the RollCall  receive and
transmit LED’s RXD, TXD will flash alternately at a 1
second rate. The unit must then be powered-down, the
code reset and the unit powered-up again.

Note that in a RollCall segment, all units must have
different unit address codes. 
For more information see RollCall Remote Control
System  Section 2. 
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OPTIONS

The DIP switch SW3 has two main functions:

1 The settings of this switch are read on power-up
when memory function is disabled or when the
preset button is pressed.
When the memory is enabled previous settings 
will be restored on power-up.

2 When a passive front panel is fitted or host
computer is not connected to the unit, this switch
allows various functions to be enabled that would
normally be set with the front panel controls or by
the host computer.

Output Scan Rate 

FUNCTION  SELECT SW 3  SETTINGS

1 2 3 4 5 6 7 8

Input Format 

De-Interlaced (1:1)* 

2x lines (2:1)* 

2x Fields (2:1)* 

1.5x lines, 1.5x Fields (2:1)*   

YPbPr 

Composite 

Y-C 

GBR 

Green Output - Syncs On

Green Output - Syncs Off

Pattern - Off 

 Pattern - Pluge 

Pattern - Bars 

Pattern - Crosshatch 

Memory Enabled (non-volaltile) 

Memory Disabled (non-volatile) 

* Depends on Input Scan Rate

Output Syncs on Green 

Pattern 

Memory 
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DATA INDICATORS

The two LED indicators D32 and D33 will become
illuminated when data is being received (D32) or is
being transmitted (D33) to the front panel. 
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SECTION 6

SUPOPS 240701  Software Version 7.0 onwards 6.1

Operating the
Supervisor Large Screen Optimiser

from a remote controller
using the RS422 interface

Version 7.x  Supervisors and above.
RollCallTM 3.0 compatible
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Supervisor remote control

The Supervisor unit uses RollCall™ which is a software protocol based around an RS422 interface. This
document describes how to use RollCall™ to interface with a Supervisor Large Screen Optimiser.

The wiring for the cable connection from Supervisor to the RS422 on a PC is drawn on page 15.

The protocol is a binary packet stream between controller and Supervisor.  Comma seperators are shown
in this document for clarity, but should not be included in the actual protocol.  Unless otherwise indicated all
numbers in this document are hexadecimal representations of 8 bit (1 BYTE) binary numbers.

Before contolling a unit, it is necessary to form a session with that unit, by way of a CONNECT
command.
Then  control of the unit is performed by use of the SET PARAMETER command with associated
data being unit specific.
It is also possible to look at the settings of the Supervisor using the GET FUNCTION STATUS
command, the reply being a RETURN FUNCTION STATUS message.
Finally once the controller no longer wishes to control the unit it can close the session with a
DISCONNECT command.

These 4 commands are Rollcall™ commands, and as such should not be confused with the Supervisor
specific commands which are carried in the data block of the SET PARAM command.

Reserved characters
The software protocol used is a packet based system which uses a start and end control byte to define the
start and end of each packet.

CMD Definition
0x02 Start of packet (STX)
0x03 End of packet (ETX)
0x1B Escape character (ESC) for STX, ETX and ESC

An escape sequence is used if the start end or escape control code values are required in the packet.  The
escape character is inserted, and the desired character has its MSB inverted.  The table below shows the 2
byte replacements.

Note that the value of the Data Length part of the packet will remain the same, since this escape character
sequence is handled at a lower level.

Value required in body of Packet. Sequence of bytes to be sent
0x02 0x1B, 0x82
0x03 0x1B, 0x83
0x1B 0x1B, 0x9B
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Sending commands

The Rollcall protocol defines the format of all messages sent to the Supervisor.  It consists of 4 distinct
parts:

i) The packet header consisting of the start byte, destination address, source stream and
destination stream.  This is constant with the exception of the Supervisors physical address.

ii) The Rollcall command, block consisting of a data length which includes the rollcall command,
the command required, (1 byte) and the command flag (1 byte).  This document details four
ROLLCALL commands.

iii) The data block,.  This varies dependant on which ROLLCALL command is sent, and is
Supervisor specific.  Use the tables at the end to fill in this section.

iv) The packet tail consisting of a checksum (use 00 to ignore) and the stop byte.

The protocol is presented below.

In this document the packet header is shaded. Only changed if hardware is altered.
The remote command is lightly shaded. Data length for command + data

CONNECT / TERMINATE / SET PARAM
                                                            / GET FUNCTION STATUS

are the four cases used in this note.
Data is left unshaded. Every Command is different.
Packet tail is shaded.  Only changed if hardware is altered.
The only difference between commands is the command number, the length of data field and the data
which is sent with the command. i.e.  the packet header is the same.

Establishing a session

CONNECT

Before commands can be sent to the supervisor unit, a session needs to be set up. The way in that this is
done, is to send a data packet with the CONNECT command. Here is the byte sequence.

Nominal Value Description.
0x02 (Start Packet (STX))

0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)  **
0x00, 0xFF (Supervisor stream index = Unknown)
0x00, 0x00 (Controller stream index)

0x00,  0x1B, 0x82 (Data length to follow, 2bytes + 0 [Value 02 is replaced.])
0x1B, 0x82 (RollCallTM CONNECT command   [Value 02 is replaced.])
0x00 (RollCallTM command flag)
Data items (Data items dependent on above; will be none.)

0x00 (Ignore Checksum)
0x03 (End packet (ETX))
i.e. 02 00 00 14 00 00 FF 00 00 00 1B 82 1B 82 00 00 03

Connects a session to the supervisor.

**NOTE: The value of the third byte in the hardware specific net address should be the value set on the
hex switch that is located on the front of the main board of the Supervisor.  If you change this
switch, substitute new value in all packets.  As shipped the value is 14H
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If the session is successfully set up an Acknowledge packet should be received from the Supervisor that
will consist of the following sequence of bytes:

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index )
0x00, 0x00 (Controller stream index )

0x00,  0x1B, 0x82 (Data length to follow)
0x01 (RollCallTM ACKNOWLEDGE command)
0x00 (RollCallTM Command flag)
Data items (None)

0xCE (Checksum)
0x03 (End packet (ETX))
i.e. 02 00 00 14 00 00 00 00 00 00 1B 82 01 00 CE 03

Acknowledges a session start from the Supervisor
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Controlling the unit

SET PARAMETER

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index )
0x00, 0x00 (Controller stream index )

0x00,  0x0A (Data length, 8 bytes for SET PARAM + 2 for Rollcall cmds)
0x10 (RollCallTM SET PARAMETER command.)
0x00 (RollCallTM command flag)
Data items (6 bytes, Supervisor specific as per following tables.)

0x00, (Ignore checksum )
0x03 (End packet (ETX))

The Data length field for SET PARAM is 8 bytes, and consists of the following:.

The command number is a word (two byte) length field which contains the number of the menu that
contains the desired command. For example, command number 00 E3 means select the pedestal
menu.

The mode is a word (two byte) length field which contains a indicator to the type of the parameter.  All
paramters listed in this document are of type VALUE. (Other options are STRING, DATA or
WRAPPED.  VALUE is indicated by 0x00 0x01.

Parameter is a long (4 byte) field, which is either the menu item that is required or a parameter value,
in 2’s compliment.  In the case of the pedestal, a parameter of 00 00 00 E4 will provide normal
pedestal; a parameter of 00 00 00 E5 will remove the pedestal .
Region marked *** is taken from the command tables.

REMOVE PEDESTAL Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index )
0x00, 0x00 (Controller stream index )

0x00,  0x0A (Data length (2 + 8 = 10) )
0x10 (RollCallTM SET PARAMETER command)
0x00 (RollCallTM command flag)

*** 0x00,  0xE3 (Command number)
*** 0x00,  0x01 (Mode number)
*** 0x00,0x00,0x00,0xE5 (Parameter)

0x00, (Ignore checksum )
0x03 (End packet (ETX))
Actual byte sequence =  02 00 00 14 00 00 00 00 00 00 0A 10 00 00 E3 00 01 00 00 00 E5 00 03
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An example of where the 2’s compliment number would be used is setting the luma gain.  To set luma gain
to 0.2 db; the packet would read;

LUMA GAIN SET TO 0.2dB  Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index )
0x00, 0x00 (Controller stream index )

0x00,  0x0A (Data length)
0x10 (RollCallTM SET PARAMETER command)
0x00 (RollCallTM command flag)

*** 0x00,  0xDD (Command number)
*** 0x00,  0x01 (Mode number)
*** 0x00,0x00,0x00,0x1B,0x82 (Parameter)

0x00, (Ignore checksum )
0x03 (End packet (ETX))
Actual byte sequence is = 02 00 00 14 00 00 00 00 00 00 0A 10 00 00 DD 00 01 00 00 00 1B 82 00 03

After each SET PARAMETER has been sent a RETURN FUNCTION STATUS packet (see below) should
be expected back from the Supervisor unit, consisting  of the following bytes:

02 00 00 14 00 00 00 00 00 00 0A 0C 00 xx xx 00 01 yy yy yy yy zz 03

where:
xx = Supervisor command number.
yy = value the above is now set to
zz = packet checksum
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Units status

GET FUNCTION STATUS

In order to find out the current parameters of the Supervisor, the RollCallTM Get Function Status command
is required, number 0BH.

0x02 ( Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x04 (Data length, 2 bytes for GET FUNCTION STATUS + 2)
0x0B (RollCallTM GET FUNCTION STATUS command.)
0x00 (RollCallTM command flag)
Data items (2 bytes, Supervisor specific as per tables.)

0x00, (Ignore checksum )
0x03 (End packet (ETX))

The Data length field for GET FUNCTION STATUS is 2 bytes.

In this case the command number is a word (two byte) length field which contains the number of the menu
that we want to know the status of.

The parameter or mode are not included in the GET FUNCTION STATUS packet since it is these which we
want to know!

Included below are a few examples of GET FUNCTION STATUS:
GET PEDESTRAL STATUS Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x04 (Data length)
0x0B (RollCallTM GET FUNTION STATUS command)
0x00 (RollCallTM command flag)

*** 0x00,  0xE3 (Command number)
0x00, (Ignore checksum )

0x03 (End packet (ETX))
Actual byte sequence =  02 00 00 14 00 00 00 00 00 00 04 0B 00 00 E3 00 03

To get the value of the luma gain to the packet would read:
GET LUMA GAIN               Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x04 (Data length)
0x0B (RollCallTM GET FUNCTION STATUS command)
0x00 (RollCallTM GET FUNCTION STATUS command flag)

*** 0x00,  0xDD (Command number)
0x00, (Ignore checksum )

0x03 (End packet (ETX))
Actual byte sequence is = 02 00 00 14 00 00 00 00 00 00 04 0B 00 00 DD 00 03
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RETURN FUNCTION STATUS

After a GET FUNCTION STATUS command has been sent a RETURN FUNCTION STATUS packet should be
expected back from the Supervisor unit, instead of an Acknowledge packet. It is in a similar format to the
commands:

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x0A (Data length, 8 bytes for RETURN FUNCT’N STATUS)
0x0C (RollCallTM RETURN FUNCTION STATUS command.)
0x00 (RollCallTM command flag)

Data items (8 bytes, Supervisor specific as per tables.)
0xZZ, (Checksum )

0x03 (End packet (ETX))

The Data length field for RETURN FUNCTION STATUS is 8 bytes, and consists of the following:
The command number is included and is a word (2 byte), and should match the command number sent in
the GET FUNCTION STATUS command.
The mode is included and is a word (2 byte), and should be 00 01 for VALUE.
The Parameter is a long (4 byte) field, which gives the current value of the paramter associated with the
command.

The following examples show possible return packages corresponding to the previous GET FUNCTION
STATUS examples:

RETURN FUNCTION STATUS’s
RETURN PEDESTAL STATUS Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x0A (Data length (8 + 2) )
0x0C (RollCallTM RETURN FUNCTION STATUS command)
0x00 (RollCallTM command flag)

*** 0x00,  0xE3 (Command number)
*** 0x00,  0x01 (Mode = value)
*** 0x00,0x00,0x00,0xE5 (Parameter)

0x8D, (Checksum )
0x03 (End packet (ETX))
Actual byte sequence =  02 00 00 14 00 00 00 00 00 00 0A 0C 00 00 E3 00 01 00 00 00 E5 8D 03
                                      (Pedestal is being removed)
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Again 2’s compliment is used to read parameters with actual values, as shown below.

LUMA GAIN STATUS                     Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)
0x00, 0x00 (Supervisor stream index)
0x00, 0x00 (Controller stream index)

0x00,  0x0A (Data length (8 + 2) )
0x0C (RollCallTM RETURN FUNCTION STATUS command)
0x00 (RollCallTM command flag)

*** 0x00,  0xDD (Command number)
*** 0x00,  0x01 (Mode = value)
*** 0x00,0x00,0x00,0x1B,0x82 (Parameter)

0xDB, (Checksum )
0x03 (End packet (ETX))
Actual byte sequence is = 02 00 00 14 00 00 00 00 00 00 0A 0C 00 00 DD 00 01 00 00 00 1B 82 DB 03
                                        (Luma gain is set to 0.2dB)
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Ending a session

DISCONNECT

When a program has stopped communicating with the Supervisor a disconnect session packet should be
sent. (This is a rare event since usually a controller will stay in session permenantly) This packet consists of
the following sequence of bytes:

DISCONNECT SESSION Packet

0x02 (Start Packet (STX))
0x00, 0x00, 0x14, 0x00 (Hardware specific, supervisor net address)  **
0x00, 0x00 (Destination stream )
0x00, 0x00 (Source stream )

0x00,  0x1B, 0x82 (Data length, 2 bytes [Value 02 is replaced.] )
0x1B, 0x83 (RollCallTM DISCONNECT command

[Value 03 is replaced.])
0x00 (RollCallTM command flag)

0x00, (Ignore checksum )
0x03 (End packet (ETX))
Actual sequence is = 02 00 00 14 00 00 00 00 00 1B 83 00 00 00 00 03

If the session is successfully terminated, an Acknowledge packet should be expected back from the
Supervisor unit.

02 00 00 14 00 00 00 00 00 00 1B 82 01 00 00 03
Acknowledge from the Supervisor

Example Session

All bytes in bold are sent to supervisor; all bytes in small text are from Supervisor.

A session with the Supervisor unit should be initiated with the following packet
02, 00, 00, 14, 00, 00, 7F, 00, 00, 1B, 82, 00, 00, 00, 00, 03
Connects a session to the Supervisor.
An Acknowledge packet will be expected back consisting of the following bytes
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 1B, 82, 01, 00, CE, 03
Acknowledge from the Supervisor.

Change Luma Gain to -3dB
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 00,  DD, 00, 01, FF, FF, FF, E2, 00, 03
Select Luma Gain to -3db
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, OC, 00, 00, DD, 00, 01, FF, FF, FF, E2, 99, 03
Acknowledge from the Supervisor.

Change Luma Gain to +3dB
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 00, DD, 00, 01, 00, 00, 00, 1E, 00, 03
Select Luma Gain to +3db
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 00, DD, 00, 01, 00, 00, 00, 1E, DA, 03
Acknowledge from the Supervisor.

The next sequence of  bytes should set Pattern Generation on.
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 00, 80, 00, 01, 00, 00, 00, 01, 00, 03
Set Pattern Generation On.
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 00, 80, 00, 01, 00, 00, 00, 01, D4, 03
Acknowledge from the Supervisor.

The next sequence of  bytes should set Pattern Generation Off.
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 00, 80, 00, 01, 00, 00, 00, 00, 00, 03
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Set Pattern Generation Off.
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 00, 80, 00, 01, 00, 00, 00, 00, D5, 03
Acknowledge from the Supervisor.

Change Aspect Ratio to 16:9- 4:3 Letterbox
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 01, 18, 00, 01, 00, 00, 01, 1B, 9B, 00, 03     ***
Select Aspect Ratio to 16:9- 4:3 Letterbox
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 01, 18, 00, 01, 00, 00, 01, 1B, 9B, 85, 03
Acknowledge from the Supervisor.

*** Note that the data length 00 0A does not change even though the escape sequence is used.

Change Aspect Ratio to Normal
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 10, 00, 01, 18, 00, 01, 00, 00, 01, 19, 00, 03
Select aspect ratio to 16:9- 4:3 Letterbox
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 01, 18, 00, 01, 00, 00, 01, 19, A2, 03
Acknowledge from the Supervisor.

Identify Luma Gain Value
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 04, 0B, 00, 00, DD, 00, 03
Get Function Status on Luma Gain
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 00, DD, 00, 01, 00, 00, 00, 1E, DA, 03
Return Function Status from the Supervisor.
Luma Gain is +3dB

Identify Pattern Generation Status
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 04, 0B, 00, 00, 80, 00, 03
Get Function Status on Pattern Generation
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 00, 80, 00, 01, 00, 00, 00, 00, D5, 03
Return Function Status from the Supervisor.
Pattern Off

Identify Aspect Ratio Status
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 04, 0B, 00, 01, 18, 00, 03
Get Function Status on Aspect Ratio
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 0A, 0C, 00, 01, 18, 00, 01, 00, 00, 01, 19, A2, 03
Return Function Status from the Supervisor.
Normal Aspect

When a program has finished the following disconnect session packet should be sent
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 1B, 82, 1B, 83, 00, 00, 03
Disconnects a session to the Supervisor.
02, 00, 00, 14, 00, 00, 00, 00, 00, 00, 1B, 82, 01, 00, CE, 03
Acknowledge from the Supervisor
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Tables to show the commands of the Supervisor

The Scale and unit field signifies the amount that the parameter sent with a command is multiplied by. For
example when the Luma Gain is being set, a value between -30 and +30 is sent which is then multiplied by
0.1 to give an actual value of -3 to +3 which has the unit dB.   The numbers are decimal in this column.

The Step unit indicates the amount by which parameters sent with a command can be stepped by. For
example the Horizontal picture size command has a range of acceptable values between 170 and 560 and
should be stepped in units of 10. This means that values like 175 and 195 are not acceptable.   This
numbers in this column are decimal.

Note: commands without a parameter field expect a number to be sent to set the actual value of the
parameter. For example the Luma gain command which expects the required value of the Luma gain to be
sent to the unit. The format of the numbers to be sent is 2’s complement 4 byte to allow negative numbers
to be sent. For commands where the range goes from negative to positive, the negative numbers can be
expressed by using binary twos complement. If the default setting for a command such as Luma gain is
required the value to send is Max Value + 1.

Menu item Function name Notes Data length Command number Parameter

Output 625 100 2:1 625 100 Output 00 06 00 C9 00 00 00 6F

Output 625 50 1:1 625 1:1 Output 00 06 00 C9 00 00 00 70

Output 1250 50 2:1 1250 HD Output 00 06 00 C9 00 00 00 7B

Output 875 75 2:1 875 75Hz 2:1 Output 00 06 00 C9 00 00 00 71

Output 525 120 2:1 525 120 Output 00 06 00 C9 00 00 00 73

Output 525 60 1:1 525 1:1 Output 00 06 00 C9 00 00 00 74

Output 1050 60 2:1 1050 HD Output 00 06 00 C9 00 00 00 79

Output 735 60 1:1 735 60 1:1 Output 00 06 00 C9 00 00 00 81

Output 735 90 2:1 735 90 2:1 Output 00 06 00 C9 00 00 00 75

Output 1125 60 2:1 1125 HD Output 00 06 00 C9 00 00 00 7A

Output VGA 320x400 1:1 CGA Output 00 06 00 C9 00 00 00 76

Output VGA 640x480 1:1 VGA Output 00 06 00 C9 00 00 00 77

Output VGA 800x600 1:1 SVGA Output 00 06 00 C9 00 00 00 78

Output Mac 640x480 1:1 Mac Output 00 06 00 C9 00 00 00 7E

Output Mac 832x624 1:1 Mac Output 00 06 00 C9 00 00 00 7F

Output Eidophor Europe Eidophor Output 00 06 00 C9 00 00 00 7C

Output Eidophor US Eidophor Output 00 06 00 C9 00 00 00 7D

Menu item Function name Notes Data Length Command number Parameter

Output Format YPbPr YPbPr output format 00 06 00 00 00 00 00 00

Output Format GBR GBR output format 00 06 00 00 00 00 00 01

Output Sync Norm Sync + 00 06 00 83 00 00 00 00

Output Sync Invert Sync - 00 06 00 83 00 00 00 01

Output Sync Off No sync on G/Y 00 06 00 85 00 00 00 00

Output Sync On Sync on G/Y 00 06 00 85 00 00 00 01

Output Sync Comp Sync Off Separate H & V 00 06 00 87 00 00 00 00

Output Sync Comp Sync On Combined H & V 00 06 00 87 00 00 00 01

NOTE:-
Eidophor outputs  are optional and are not available on all units.
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Menu item Function name Notes Data length Command number Parameter

Input Type YPbPr YPbPr input 00 06 00 81 00 00 00 0C

Input Type GBR GBR input 00 06 00 81 00 00 00 00

Input Type YC YC input 00 06 00 81 00 00 00 04

Input Type Composite Composite input 00 06 00 81 00 00 00 08

Input Type VGA VGA input 00 06 00 81 00 00 00 0E

Menu item Function name Notes Data Length Command Number Parameter

Insync Sync on G/Y Input Sync on G/Y 00 06 00 CA 00 00 00 D0

Insync Ext 0.3V Syncs Input Sync on external 0.3 Syncs 00 06 00 CA 00 00 00 D1

Insync Ext 2.0V Syncs Input Sync on external 2.0V Syncs 00 06 00 CA 00 00 00 D2

Insync Ext HD Syncs Input Syncs on external HD Syncs 00 06 00 CA 00 00 00 D3

Menu item Function name Notes Data length Command number Parameter

Input Auto Auto std detect for input 00 06 00 C8 00 00 00 65

Input 625 50 2:1 625 Input 00 06 00 C8 00 00 00 66

Input 525 60 2:1 525 Input 00 06 00 C8 00 00 00 67

Input CGA 320x400 1:1 CGA Input 00 06 00 C8 00 00 00 68

Input VGA 640x480 1:1 VGA Input 00 06 00 C8 00 00 00 69

Input SVGA 800x600 1:1 SVGA Input 00 06 00 C8 00 00 00 6A

Input 1250 50 2:1 1250 Input 00 06 00 C8 00 00 00 6B

Input 1125 60 2:1 1125 Input 00 06 00 C8 00 00 00 6C

Input 1050 60 2:1 1050 Input 00 06 00 C8 00 00 00 6D

Input Mac 832x624 1:1 Mac Input 00 06 00 C8 00 00 00 6B

NOTE:-
HD inputs  are optional and not available on all units.

Menu item Function name Notes Data Length Command number Parameter

Pattern Menu 100% Bars Select 100% Bars 00 06 00 E6 00 00 00 0A

Pattern Menu Bars & Red Select Bars & Red 00 06 00 E6 00 00 00 0B

Pattern Menu Cross Hatch Select Cross Hatch 00 06 00 E6 00 00 00 0C

Pattern Menu Step (Gamma) Select Gamma Step 00 06 00 E6 00 00 00 0D

Pattern Menu Ramp Select Ramp 00 06 00 E6 00 00 00 0E

Pattern Menu M-Burst Select M-Burst 00 06 00 E6 00 00 00 0F

Pattern Menu Pluge Select Pluge 00 06 00 E6 00 00 00 10

Pattern Menu Black Select Black 00 06 00 E6 00 00 00 11

Pattern Menu White Select White 00 06 00 E6 00 00 00 12

Pattern Menu Pattern On Turn pattern on 00 06 00 80 00 00 00 01

Pattern Menu Pattern Off Turn pattern off 00 06 00 80 00 00 00 00

Menu item Function
name

Notes Data
Length

Command
number

Parameter
Min value Max value

Scale and
unit

Step

Analogue Control. Luma Gain Select Luma Gain 00 06 * 00 DD FF FF FF E2 00 00 00 1E 0.1 (dB) 1

Analogue Control Chroma Gain Select Chroma Gain 00 06 * 00 DE FF FF FF E2 00 00 00 1E 0.1 (dB) 1

Analogue Control Black Level Select Black Level 00 06 * 00 DF FF FF FF CE 00 00 00 32 1 (mV) 1

* The data length will be 00 0A even if parameter required is 0x02, 0x03 or 0x1B.
Menu item Function name Notes Data Length Command number Parameter

Pedestal Pedestal Normal No Pedestal 00 06 00 E3 00 00 00 E4

Pedestal Pedestal Remove Remove Pedestal 00 06 00 E3 00 00 00 E5
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Menu item Function name Notes Data
Length

Command
number

Min value Max value Scale
and unit

Step

Hue NTSC Hue NTSC Hue 00 06 * 00 E0 FF FF FF EC 00 00 00 14 1 (deg) 2

YC_H YC delay (H) Horizontal Y/C delay 00 06 * 00 E1 FF FF FF F0 00 00 00 10 1 1

YC_V YC delay (V) Vertical Y/C delay 00 06 * 00 E2 FF FF FF F8 00 00 00 08 1 2

Henh Horiz Sharp Horizontal Sharpening 00 06 * 00 FD 00 00 00 00 00 00 00 5A 0.1(dB) 1E
Venh Vert Sharp Vertical Sharpening 00 06 * 00 FC 00 00 00 00 00 00 00 5A 0.1(dB) 1E

Gamma Gamma Gamma select 00 06 * 00 FE 00 00 00 00 00 00 00 09 1 1

Horizsize Horiz size Horizontal size 00 06 +* 00 D4 FF FF FF 80 00 00 07 9C 1 10

Vertsize Vert size Vertical size 00 06 00 D5 FF FF FF F6 00 00 00 B4 0.5 1

Horizpan Pan Horizontal Pan 00 06 * 00 D7 00 00 00 00 00 00 00 C8 1 1

Verttilt Tilt Vertical tilt 00 06 * 00 D6 00 00 00 00 00 00 00 C8 1 1

Menu item Function name Notes Data Length Command number Parameter

Aspect ratio Normal Normal Aspect 00 06 01 18 00 00 01 19

Aspect ratio 16:9-4:3 16:9-4:3 Side Crop 00 06 01 18 00 00 01 1A

Aspect ratio 16:9-4:3 16:9-4:3 Letterbox 00 06 01 18 00 00 01 1B

Aspect ratio 4:3-16:9 4:3-16:9 Curtain 00 06 01 18 00 00 01 1C

Aspect ratio 4:3-16:9 4:3-16:9 Top Crop 00 06 01 18 00 00 01 1D

Menu item Function name Notes Data
Length

Command
number

Parameter Min value Max value Scale Step

VGA Options Wipe VGA Wipe select 00 06 01 09 00 00 00 00

VGA Options Key VGA Key select 00 06 01 09 00 00 00 00

VGA Threshold Key Threshold VGA Key Threshold 00 06 * 01 0B 00 00 00 00 00 00 00 3F 1 1

Horiz wipe point H Wipe Adjust VGA Horiz Wipe
Point

00 06 +* 01 0D 00 00 00 00 00 00 01 F4 1 1

Vert wipe point V Wipe Adjust VGA Vert Wipe Point 00 06 +* 01 0C 00 00 00 00 00 00 02 58 1 1

Horiz wipe invert on H wipe invert Inversion Activate 00 06 01 06 00 00 00 01

Horiz wipe invert off H wipe norm Inversion off. 00 06 01 06 00 00 00 00

Vert wipe invert on V wipe invert Inversion Activate 00 06 01 12 00 00 00 01

Vert wipe invert off V wipe norm Inversion off. 00 06 01 12 00 00 00 00

Total key Invert on Key signal invert Inversion Activate 00 06 01 07 00 00 00 01

Total key Invert off Key signal norm Inversion off. 00 06 01 07 00 00 00 00

VGA key on Key active VGA key Activate 00 06 01 08 00 00 00 01

VGA key off Key inactive VGA Key  off 00 06 01 08 00 00 00 00

Menu item Function name Notes Data Length Command number Parameter

Effects Freeze Freeze on 00 06 01 0F 00 00 00 01

Effects Freeze Freeze off 00 06 01 0F 00 00 00 00

Effects Mono Mono on 00 06 01 10 00 00 00 01

Effects Mono Mono off 00 06 01 10 00 00 00 00

Effects Invert Invert on 00 06 01 11 00 00 00 01

Effects Invert Invert off 00 06 01 11 00 00 00 00

* The data length will be 00 0A even if parameter required is 0x02, 0x03 or 0x1B.

NOTE:-
Horizontal VGA wipe is only available from version 6.0 software onwards.  In version 5.x Total key invert is used instead of Vert wipe invert
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Menu item Function name Notes Data Length Command number Parameter

Wall Select Wall 1H x 2V Video Wall shape 00 06 01 54 00 00 01 55

Wall Select Wall 1H x 3V Video Wall shape 00 06 01 54 00 00 01 56

Wall Select Wall 1H x 4V Video Wall shape 00 06 01 54 00 00 01 57

Wall Select Wall 2H x 1V Video Wall shape 00 06 01 54 00 00 01 58

Wall Select Wall 2H x 2V Video Wall shape 00 06 01 54 00 00 01 59

Wall Select Wall 2H x 3V Video Wall shape 00 06 01 54 00 00 01 5A

Wall Select Wall 2H x 4V Video Wall shape 00 06 01 54 00 00 01 5B

Wall Select Wall 3H x 1V Video Wall shape 00 06 01 54 00 00 01 5C

Wall Select Wall 3H x 2V Video Wall shape 00 06 01 54 00 00 01 5D

Wall Select Wall 3H x 3V Video Wall shape 00 06 01 54 00 00 01 5E

Wall Select Wall 3H x 4V Video Wall shape 00 06 01 54 00 00 01 5F

Wall Select Wall 4H x 1V Video Wall shape 00 06 01 54 00 00 01 60

Wall Select Wall 4H x 2V Video Wall shape 00 06 01 54 00 00 01 61

Wall Select Wall 4H x 3V Video Wall shape 00 06 01 54 00 00 01 62

Wall Select Wall 4H x 4V Video Wall shape 00 06 01 54 00 00 01 63

Menu item Function name Notes Data Length Command
number

Min value Max value Scale Step

Cube Select Cube Select Select video wall cube 00 06 * 01 68 00 00 00 00 00 00 00 10 1 1

Menu item Function name Notes Data Length Command number Parameter

Genlock Menu Off Genlock Off 00 06 01 22 00 00 00 5B

Genlock Menu Reference Reference Genlock On 00 06 01 22 00 00 00 5C

Genlock Menu Digital Digital Genlock On 00 06 01 22 00 00 00 5D

Menu item Function name Notes Data Length Command
number

Min value Max value Scale Step

Genlock H Phase Genlock H Phase 00  06 * 00 5E 00 00 00 00 00 00 00 7F 1 1

Genlock V Phase Genlock V Phase 00 06 * 00 5F FF FF FF FC 00 00 00 04 1 1

Menu item Function name Notes Data Length Command number Parameter

System Preset Unit Return unit to Presets 00 06 01 3D 00 00 00 00

System Clear Mem Clear memories 00 06 01 34 00 00 00 01

System VHS Mode VHS mode PLL off 00 06 01 30 00 00 00 00

System VHS Mode VHS mode PLL on 00 06 01 30 00 00 00 01

System IO Lock IO Lock off 00 06 01 31 00 00 00 00

System IO Lock IO Lock auto 00 06 01 31 00 00 00 02

Menu item Function name Notes Data Length Command number Parameter

Save Menu Save 1 Save to memory 1 00 06 01 40 00 00 01 41

Save Menu Save 2 Save to memory 2 00 06 01 40 00 00 01 42

Save Menu Save 3 Save to memory 3 00 06 01 40 00 00 01 43

Save Menu Save 4 Save to memory 4 00 06 01 40 00 00 01 44

Save MenU Save 5 Save to memory 5 00 06 01 40 00 00 01 45

Menu item Function name Notes Data Length Command number Parameter

Recall Menu Read 1 Read memory 1 00 06 01 4A 00 00 01 41

Recall Menu Read 2 Read memory 2 00 06 01 4A 00 00 01 42

Recall Menu Read 3 Read memory 3 00 06 01 4A 00 00 01 43

Recall Menu Read 4 Read memory 4 00 06 01 4A 00 00 01 44

Recall Menu Read 5 Read memory 5 00 06 01 4A 00 00 01 45

* The data length will be 00 0A even if parameter required is 0x02, 0x03 or 0x1B.
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Wiring for SuperVisor RS422 Interface to PC RS422 Interface

Baud Rate: 38 400
Parity: None
Data: 8 Bits
Stop Bits: 1

PC End
RS422 on PC SuperVisor End

Tx +ve (A) 7 Tx +ve

Tx -ve (B) 2 Tx -ve

Rx +ve (A) 3 Rx +ve

Rx -ve (B) 8 Rx -ve

Ground 6 Ground **

Note:
Do not connect to any other pins on the SuperVisor 9 way D-type connector
**Ground is on pins 1, 4, 6 & 9. Connect to any one of these pins.
Pin 5 is power  and no connection should be made to this pin.


